A technical guide to the major differences between Altium Designer 2004 and Altium Designer 6.8
Contents

Securing your future with Altium Designer 6 2
1. A more productive environment for complex board design 4
2. Tools to conquer the routing challenge for signaling technologies 10
3. Create great designs without constraints – shaping the modern board 25
4. Design documentation linked to everyone in your organization 28
5. Integrate and manage libraries – protect and re-use your valuable component IP 32
6. Manage increased design complexity and be quicker to market 36
7. Make the move to a superior design environment – and take your designs with you 45
8. Enhanced circuit analysis capabilities with Spice, PSpice® and SIMetrix/SIMPLIS – move to the working board with confidence 50
9. Embed an entire system in an FPGA – no new skills needed 53
10. Keep up to date with Altium Designer 68
Securing your future with Altium Designer 6

As an electronics professional you’ll be more than aware of the rapid and ongoing evolution of electronics design technology and techniques. Keeping pace with this evolution is crucial to remaining competitive in today’s industry, so your development tools need to improve as the technology and industry change.

In the period since its 2005 release, Altium Designer 6 has been substantially developed with hundreds of new features and refinements to meet these needs. The latest update – Altium Designer 6.8 – brings new technology and productivity enhancements to all stages of the design process, from the design of high-speed boards through to using the latest in programmable device technology.

Rather than pointing you at a collection of what’s new documents, we thought you would appreciate a collated view of the very best of these developments. We’ve clustered them into 10 areas, which we think makes for 10 very compelling reasons to consider now a good time to upgrade to Altium Designer 6.

10 Secrets of Design Success – reasons to upgrade to Altium Designer 6

1. A more productive environment for complex board design
Dreamt of the day that you could zoom and pan around a 3D view of your complex PCB, visualizing the fabricated board? Now you can – by harnessing the graphics power of DirectX with Shader Model 3.0, your PCB editing efficiency just cranked up a gear or two. Toggle the display from 2D to 3D, and turn and rotate the board as if you were holding it in your hand. And as for working on the bottom side of the board, forget the mirrors, just select Flip Board from the menus and it’s as easy as working on the top side. Improved embedded board array support, a polygon manager that gives complete control over all polygons in the design, slots in PCB pads, PCB layer sets, and a host of view management options, all work together to deliver a more productive board design environment.

2. Tools to conquer the routing challenge for signaling technologies
Device switching speeds and new signaling technologies mean you need to work with the routing as part of the circuit, not as ‘ideal interconnects’. Comprehensive signal integrity tools, impedance controlled interactive routing, differential pair routing, and interactive single-sided and differential pair length tuning, all work together to ensure your signals arrive on time, and in sync. Backed up by slick multi-trace routing and multi-trace dragging, pin and part swapping, and BGA escape routing, mean you will stay on top of your routing challenge.

3. Create great designs without constraints – shaping the modern board
STEP in sync with your MCAD colleagues, who will be more than happy with the improved 3D support. Import STEP format component models into Altium Designer 6, and then pass back a STEP format 3D file of the completed board – ECAD to MCAD integration is now possible. Full support for complex board shapes with cutouts ensures you can design and fabricate the exact board shape your product needs.

4. Design documentation linked to everyone in your organization
Delivering good design documentation is part of your job, and you like to excel at what you do. Like to reduce the time it takes to generate the BOM, pick and place, and all the other design output files? You can publish multiple print-type outputs into a single PDF using built-in PDF generation capabilities. Mix and match data from the components on both the schematic and the PCB, and even include company database info into the BOM without it tagging along in the schematic. Copy from the PCB editor into other Windows applications, or paste graphic or text data directly onto the schematic, or the PCB. True Type fonts on your PCB means more than your favourite font face, now you can display characters from any language available on your PC, right on the board. PCB barcodes are also fully supported.

5. Integrate and manage libraries – protect and re-use your valuable component IP
Your component libraries are a core company design resource, and meshing them with your company database is becoming a must-have requirement. Altium Designer 6’s database libraries (DBLib) solve the CAD tool-to-database linkage dilemma, letting you place straight from the database onto your schematic. The component identification system lets you manage the component-to-library relationships, and footprint management tools give you project-wide footprint control on both the schematic and the PCB, all making for a better component management solution.
6. Manage increased design complexity – and be quicker to market

Using signal harnesses, you can deliver simpler and more readable schematics, and reduce the overall complexity of the project structure. Bundling any combination of nets, buses and lower level harnesses, signal harnesses give you un-paralleled flexibility in how you structure your design. Another approach to managing increasing complexity is to reuse existing, proven sections of circuitry. Device sheets deliver a simple yet elegant mechanism to achieve this, reuse can range from a single schematic through to an entire multi-sheet branch of a previous design. Backed up by annotation capabilities that ensure each component in your current project has a unique designator without modifying the original schematic, device sheet deliver on that often promised catch-cry of design reuse. And if you assemble different variations of the same base design, then you need to explore Altium Designer 6’s variant management and printing capabilities. Version control systems can be accessed directly from within Altium Designer 6, and if your VCS supports it, batch, or atomic commit actions performed.

7. Make the move to a superior design environment – and take your designs with you

Making the move to Altium Designer 6 from an older legacy tool? Moving from DxDsigner®, OrCAD® or PADS® is fully supported, via the comprehensive and easy to use Import Wizard. And when you are in the middle of editing, have you ever wanted to wave your wand and transform those net labels into ports, or those sheet entries into wires + net labels + ports? It’s called Smart Paste, and it does that and much more. In place text editing, automatic sheet entry creation, customizable mouse wheel behavior and fast mouse zooming all go toward making Altium Designer 6 a better design environment.

8. Enhanced circuit analysis capabilities with Spice, PSpice® and SiMetrix/SIMPLIS – move to the working board with confidence

Creating boards that are correct by design is an essential element in successful design. Mixed-signal circuit simulation in Altium Designer 6 is enhanced by PSpice® model, functions and variables support, plus flexible new configuration options. And if you design power systems, then you’ve probably heard of the SiMetrix/SIMPLIS® circuit simulation package from Catena. You can run a SiMetrix/SIMPLIS simulation directly from Altium Designer 6.

9. Embed an entire system in an FPGA – no new skills needed

If you are not already working with FPGAs, you will be in the future. Expanding greatly on its vendor-independent FPGA design capabilities with expanded vendor and device support, Altium Designer 6 also includes embedded tool chains and hardware support for the ARM, PowerPC, MicroBlaze and NIOS 32 bit processors. Better still, system-wide support for application re-targeting means you are no longer locked to any one processor. And system design suddenly became much simpler, with the intuitive and diagrammatic OpenBus system. Opening up the parallel power of FPGAs to embedded programmers, the C-to-hardware compiler moves computationally intensive algorithms from C straight into the FPGA hardware. JTAG support for any device in the chain, a comprehensive set of virtual instruments that includes a configurable LAX that can display disassembled code, the list of FPGA-based embedded system development capabilities goes on and on.

10. Keep up to date with Altium Designer

Phew, so much to learn and so little time! Take 5 and visit the DEMOcenter, where you can watch a short video of your favorite new feature. And when you are ready to start working with Altium Designer 6 a visit to the TRAININGcenter will be well worth your while – the growing resource of over 100 focused on-line training videos will definitely accelerate your learning. If reading is your thing, then press F1 over any object, command or dialog to load dynamic help into the new Knowledge Center panel. While you’re there, why not check out the new PDF-based documentation library and the powerful PDF search capabilities.

These are just some of the new Altium Designer 6 technologies and capabilities that will enhance your productivity across the entire product development process. Read on for more details of how upgrading to Altium Designer 6.8 will keep your design capabilities up-to-date.
1. A more productive environment for complex board design

PCB routing is no longer a sophisticated join the dots process. Device switching speeds and modern interfacing technologies demand that the designer works with the routing as part of the entire circuit. To get the signal energy from the output pin, across the board to the input pin, and then back again, all in sync with related signals, you need to be able to monitor and manage the impedance properties of the routing, and control the route lengths. To achieve this you need: signal integrity tools that work at both the schematic and PCB, impedance controlled routing, differential pair routing, and route length management tools.

Altium Designer 6 delivers all of these, complete with support for signal integrity analysis on the programmed FPGA, pin/part swapping that supports FPGAs and differential pairs, and a brace of smart route editing tools that will dramatically improve your routing efficiency.

Controlled impedance routing

Altium Designer 6 delivers controlled impedance routing through a combination of features, including:

- Pre-layout signal integrity analysis on the schematic – allowing you to anticipate potential impedance mismatches and explore and include suitable termination options.
- Impedance controlled interactive routing – simply select to route by impedance, Altium Designer 6 will automatically set the routing width on each layer to achieve that impedance.
- Post-layout signal integrity analysis – check the routed board for signal quality, and examine the reflection and crosstalk waveforms of critical nets.
- Building on this, Altium Designer 6 now supports post-layout signal integrity analysis for all programmed FPGAs in the design. Correct pin models are automatically selected, to suit the programmed state of each pin.

Differential pairs

Differential signaling is fast becoming a preferred signaling interface method, driven by the ever increasing signal speeds in electronic components. By their very nature FPGAs are ideally suited to high-speed designs, and in support of this FPGA vendors are including differential signaling capabilities (LVDS), from their lower-cost devices right through to their high-end 1500+ pin mega-gate devices.

Altium Designer 6 has excellent support for differential signaling – from defining pairs on the schematic, through to interactive differential pair routing on the PCB, with differential pin-pair swapping.
Viewing and Managing the Pairs

Differential pair definitions are viewed and managed in the PCB editor panel, set to Differential Pairs Editor.

Applicable design rules

There are 3 design rules you need to configure to route a differential pair:

- **Routing Width** – defines the routing width required for both nets in the pair. Set the scope of this rule to target objects that are members of a differential pair, eg. InDifferentialPair.

- **Differential Pairs Routing** – defines the separation between the nets in the pair, the gap allowed, and the overall uncoupled length. Set the scope of this rule to target objects that are a differential pair, eg. IsDifferentialPair.

- **Match Net Length** – define how much the overall routing lengths can differ for the two nets in the pair. Set the scope of this rule to target objects that are a differential pair, eg. IsDifferentialPair.

Routing a differential pair

Differential pairs are routed as a pair – that is you route the two nets simultaneously. After selecting Differential Pair Routing from the Place menu, you click on one of the pairs in the net to start routing. To change the routing behavior as you route, press Shift+F1 to display the available shortcuts.

Interactive length tuning

Matching route lengths is a standard technique for maintain data integrity in a high-speed digital system, and an essential ingredient of differential pair routing. **Interactive Length Tuning** delivers a dynamic means of optimizing and controlling net lengths by inserting variable amplitude routing patterns, according to the available space, rules, and obstacles in your design. Launched from the Tools menu, length tuning can be based on design rules, properties of the net, or values you enter into a dialog. Differential pair lengths can be tuned with the Interactive Diff Pair Length Tuning command.

Once you have launched the command, tuning segments are added by moving the mouse along the routed net. The Interactive Length Tuning cursor will guide you during the tuning process. The yellow cursor bars indicate the possible minimum and maximum lengths. The green bar indicates the target length, as determined from the applicable Matched Length and Max Length design rules, or the settings in the Interactive Length Tuning dialog. The sliding indicator shows how close you are to achieving a match.

The length tuning can be created from straight or arc segments, with full control over the amplitude, pitch and corner radius. Press Tab during tuning to access the Length Tuning dialog, or press Shift+F1 to see the interactive shortcut keys.

Figure 3. Length Tuning can be performed on individual nets, or differential pairs.
Multi-trace routing

There are often multiple connections that run between 2 components on the board, such as the nets in a bus. Using the multiple-trace routing command, you can quickly route any number of nets. To route multiple traces, first select the net objects where routing is to commence from, such as the pads or existing track segments. The new Select Touching tools are ideal for this. Any set of nets can be included in a multi-trace route, they do not need to belong to a net class. After choosing the Multiple Traces command from the Place menu, click on one of the selected objects to start routing. The traces will automatically gather as you leave component pads.

Press Tab during routing to access the Bus Routing dialog, where you can control the gather, or press Shift+F1 to see the interactive shortcut keys.

Smart Interactive Routing

Smart Interactive Routing is an excellent tool for quickly routing short connections. Smart Interactive Routing works with you in an intuitive way, attempting to completely route the chosen connection along the shortest path, using horizontal, vertical and diagonal segments, while automatically walking around any obstacle along the path. Smart Interactive Routing can automatically complete the entire connection if both the start and end nodes are on the same layer, while meeting any applicable design rules.

Press Shift+F1 during Smart Interactive Routing to see the available shortcut keys.

Figure 4. Quickly route multiple traces, press Tab to control the gather on pad exit.

Figure 5. A connection being Smart Routed, by holding Ctrl it only takes a single click to completely route the connection.
BGA escape routing

Altium Designer 6’s BGA fanout capabilities have been strengthened by the addition of optional escape routing. Now when you right-click on the component and select Fanout Component from the context menu, you can choose to include escape routes. Escape routes are short sections of routing placed in a logical row-per-layer fashion, that bring each net out to the edge of the device. Escape routes are placed in accordance with applicable routing width, clearance and via style design rules. You also now have the option of fanning out the outer 2 rows of BGA pads.

Figure 6. Note how the escape route feature presents each connected pad as an accessible route outside the edge of the BGA.

Refined interactive routing

Appreciating that small changes can deliver strong productivity improvements, Altium Designer 6 now includes a routing completion detector. Once enabled, the Automatically Terminate Routing option automatically drops the connection being routed when you hit a target pad, leaving you ready to start routing the next connection.

Routing Width selection has also been simplified, you can now press Shift+W to pop up a list of pre-defined preferred routing widths. Rule compliance is still enforced, you will be automatically clipped if you select a width outside the applicable routing width rule. Press Shift+V as you route to select a different via size. Configure these options in the Interactive Routing page of the Preferences dialog.

You’re probably familiar with Altium Designer’s loop removal capabilities, an excellent feature for efficient re-routing. There are times when you need to form routing loops though, in Altium Designer 6 you can do this by double-clicking on the net name in the PCB panel and disabling the Remove Loops checkbox.

Figure 7. Control the loop removal for an individual net in the Edit Net dialog.

<table>
<thead>
<tr>
<th>Imperial</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Units</td>
</tr>
<tr>
<td>5 mil</td>
<td>0.127 mm</td>
</tr>
<tr>
<td>6 mil</td>
<td>0.152 mm</td>
</tr>
<tr>
<td>7 mil</td>
<td>0.203 mm</td>
</tr>
<tr>
<td>10 mil</td>
<td>0.254 mm</td>
</tr>
<tr>
<td>12 mil</td>
<td>0.305 mm</td>
</tr>
<tr>
<td>20 mil</td>
<td>0.508 mm</td>
</tr>
<tr>
<td>25 mil</td>
<td>0.635 mm</td>
</tr>
<tr>
<td>50 mil</td>
<td>1.27 mm</td>
</tr>
<tr>
<td>100 mil</td>
<td>2.54 mm</td>
</tr>
<tr>
<td>305 mil</td>
<td>7.72 mm</td>
</tr>
<tr>
<td>1 inch</td>
<td>25.4 mm</td>
</tr>
<tr>
<td>10 mil</td>
<td>0.254 mm</td>
</tr>
<tr>
<td>20 mil</td>
<td>0.508 mm</td>
</tr>
<tr>
<td>25 mil</td>
<td>0.635 mm</td>
</tr>
<tr>
<td>35 mil</td>
<td>0.889 mm</td>
</tr>
<tr>
<td>50 mil</td>
<td>1.27 mm</td>
</tr>
</tbody>
</table>

Figure 8. Press Shift+W during routing to change the routing width.
Smart multi-track dragging with angle preservation

Re-routing is not always the best approach to modifying the routing, it is often easier to move existing segments. Ideally, you would like any connected segments to maintain their orientation and angle of connection, to the segment being moved.

Altium Designer 6 supports this, with smart multi-track dragging with angle preservation. To drag multiple segments, select the segments first, using one of the new selection tools. To drag an individual segment without pre-selecting, hold the Ctrl key as you click and drag.

There are also special modes when you start dragging on one of the track vertices. Press Tab during dragging to display the Preserve Angle Dragging dialog, or press Shift+F1 to see the available shortcut keys.

Figure 9. Drag multiple track segments, while preserving the angles.

Track slicing and Smart dragging

Another neat time saving feature in Altium Designer 6 is the new track slicer. Select Slice Tracks from the Edit menu, and then click to start slicing tracks. Press Tab to define the blade width, press Shift+F1 to choose a shortcut option, such as Select Sliced Tracks to the Right.

The track slicer works hand in hand with Altium Designer 6’s smart dragging capabilities, for example once you have sliced a set of tracks you can click on one of the selected track ends, and smart drag all the ends to re-shape the routing. Using a combination of drag and release mouse actions, you can quickly build a new route shape.

Figure 10. Slice multiple track segments, and then smart drag the selected set to re-shape the routing.
Pin and part swapping with dynamic net assignment

Altium Designer 6’s pin and part swapping capabilities not only delivers an excellent pin/part swap solution for simple components, such as resistor networks, they also support sophisticated devices such as programmed FPGAs, with full awareness of device banks and the programmed pins’ IO state.

Built into the pin/part swap tool is dynamic net assignment. Dynamic net assignment means you can perform swaps on pins with partially routed nets. Using this, you can neatly route a set of nets from the pins at each end of the connection, then perform swaps to de-tangle the connection lines where they meet. As well as interactive pin and part swapping commands, Altium Designer 6 also includes an automatic pin optimizer, ideal for swapping a large number of pins to quickly reduce the routing complexity.

This level of functionality means that partially routed nets and pre-routed multilayer escapes from complex BGA devices can now be swapped. Differential pairs can now also be swapped, taking advantage of the knowledge about differential pin-pairs on FPGAs.

![Figure 11. A simple example to show how you can ignore the connection lines, routing the used pins from either end, as shown in the image on the left. You can then run the optimizer to dynamically update the routing and connection lines, or interactively swap the pins, as shown in the image on the right.](image)

PCB selection tools, selection touching line, touching rectangle

Selection is a core function in your editing toolset, being used constantly during the design process. Altium Designer 6’s new selection tools greatly simplify the process of building up a selection set in the PCB. The new selection features can be accessed from the Selection submenu (press S) and include:

- **Select Touching Rectangle** – any object touched by the selection rectangle will be selected.
- **Select Touching Line** – any object touched by the selection line will be selected.
- Hold the Shift key after choosing the command to add to an existing selection set.
- To select multiple pads in a component, hold Ctrl as you perform the selection.

![Figure 12. Use the Select Touching commands to select specific objects in a dense workspace.](image)
2. Tools to conquer the routing challenge for signaling technologies

Good board design is not a trivial task – it takes great skill, patience, and a design environment that works with you. Altium Designer 6 incorporates a large number of enhancements that help you throughout the board design process. Frustration-easing features like the new hardware graphics engine mean that you can zoom and pan around that large and complex board design as quickly as if it had only 2 layers and 6 components. Displaying the board in a realistic 3D mode is as easy as pressing a shortcut key. Turn and rotate the 3D board, and zoom in to examine the most minute detail. Need to work on the bottom of the board, then flip the view to turn the board over, and continue designing. And there is a suite of features to help you manage your view of that complex multilayer board. Called the Board Insight system, it includes a heads-up display, a magnifying lens, and enhanced single layer display. Put the Insight system together with the new layer control options and you’ll understand why you feel so good about moving to Altium Designer 6.

Hardware graphics engine

Altium Designer 6 sports a new Hardware Accelerated Graphics Engine in the PCB editor. This engine provides a substantial increase in drawing speed over the current GDI-based graphics engine, providing smooth, real-time graphics within the PCB editor. The redraw speed is effectively instant, even on the largest PCBs. The new graphics engine is built around the Shader Model 3.0 technology supported by Microsoft DirectX 9.0c. Traditionally the graphics card is treated as a dumb pixel painter, where the application code first renders the image as a bitmap in memory, and then passes all of the pixel data from the main CPU to the GPU. Using Shader modeling technology the rendering code is executed on the GPU, the application code issues instructions to the GPU to render a particular type of object, supplying a minimal set of data such as object location, color, lighting, and so on.

In the case of Altium Designer’s PCB editor, this means that rather than passing a large number of pixels, that when rendered paint a track object on the screen, the GPU is programmed to know how to draw a track – Altium Designer simply passes location coordinates, width and color information. The new Hardware Accelerated Graphics Engine:

- Provides substantial drawing speed improvements over GDI.
- Removes the impact of polygons on drawing speed.
- Provides smooth panning and scrolling, at all zoom levels.
- Maintains drawing and panning performance for the largest of boards.
- Has been tested and benchmarked on a wide variety of graphics cards.
- Works in harmony with the existing graphics engine, allowing you to switch between them as needed.

Note that the new graphics engine requires a graphics card that supports DirectX® 9.0c and Shader Model 3.0. As well as speed improvements, the graphics engine also delivers cleaner and clearer display features. Selections are easier to see, and there are improvements to how large objects, such as polygons and component bodies, are displayed.

![Figure 13](image.png)

Figure 13. As well as speed improvements, the graphics engine also delivers cleaner and clearer display features. Here you can clearly see that there are overlaid component body objects in the large component in the image on the left. The image on the right shows a selected polygon, note how the polygon’s clearance from other copper can now be seen.
2D & 3D PCB Visualization

Visualizing the 3 dimensions of a board design is not trivial when you are looking at a flat, multi-layered view of a complex board design. Altium Designer 6 includes a new 3D visualization mode in the PCB editor.

Work in a 2D or a 3D view

Building on the capabilities offered by the new DirectX graphics engine, Altium Designer 6 can display the board in both the traditional, viewed-from-above 2 dimensional style, or in a realistic, 3 dimensional view.

Presenting the board in a 3 dimensional view is like holding it in your hand, with a pair of magnifying goggles strapped to your head. Not only can you can freely turn and rotate the board, you can also zoom in to examine the most minute detail. The board is realistically rendered according to the X-Y sizes of the objects, and the material thicknesses defined in the layer stackup.

Switching from 2D to 3D mode is as easy as pressing the 3 shortcut, with the 2 shortcut taking you back to 2D again. Holding the shift key as you press the right mouse button presents a spherical proximity-sensitive cursor, which can be used to perform free or axis-constrained rotations. The cursor remains on the plane of the board itself, making it easy to tilt and rotate the board in a controlled manner. Press the 0 (zero) key to return to a flat 3D view.

Apart from making your board look great, the 3D view is ideal for previewing the fabricated board. Use it to help you spot those small detail issues that you only seem to notice on the fabricated board. Issues such as silkscreen over holes, mask over holes, unplated holes and incorrectly oriented polarized components all seem to stand out on the blank 3D board. And if you have included component bodies in the footprints you can display these too, helping identify potential pick and place assembly problems created by component crowding. Browsing components from the PCB panel takes on a whole new dimension in 3D mode too, as you flyover the board to locate the component, on either side of the board.

Save your display configurations

Supporting the new view options, all display related settings, such as the colors used, layers displayed, opacity of layers, and so on, can be configured and saved as a View Configuration. Changing the look of the board is then as simple as selecting a different view configuration, either from the main PCB toolbar, or in the View Configurations dialog.

View configurations are saved in your user profile folder on your PC, and the currently selected configuration name is saved with the board – ensuring that the correct view configuration is automatically applied when each board is opened.
**3D Visualization panel**

Complimenting the 3D presentation of the board in the main workspace, the **3D Visualization Panel** provides three additional 3D views. These include a horizontal cross section, a vertical cross section, and a general purpose 3D Insight view, each having its own zoom and pan capabilities via the mouse buttons. The sectional views are ideal for examining the internal connections in a dense multilayer board, by adjusting the opacity and thickness at the top of the panel any internal area of the board can be completely detailed.

The 3D Visualization panel provides an ideal companion for when you are working with the main workspace in 2D mode, giving you side-by-side 2D and 3D views.

**Flip and edit the board**

In Altium Designer 6 you can work on the bottom of the board as easily as you work on the top. Use the **View » Flip Board** command to turn over the entire workspace, just as if you were turning over the board in your hand. All standard actions and editing commands are supported, including routing, positioning components, and positioning text. Simply select the command again to flip the board back.

The coordinate space remains logically the same, so the workspace origin moves from the bottom left to the bottom right, and the current grid position increases in the X direction as you move the mouse from right to left, instead of the normal left to right. Any output generated while the view is flipped will maintain the correct viewed-from-top coordinate information.

The layer drawing order is also changed, using a logical-pair swapping process. This means that TopOverlay will swap positions in the current layer drawing order with BottomOverlay, TopLayer with BottomLayer, Mid Layer1 with Mid Layer30, Internal Plane1 with Internal Plane16, and so on. The drawing order of mechanical layers is not changed.

**Space Navigator**

Complimenting the new 3D visualization mode is support for the **SpaceNavigator™**. The SpaceNavigator is a 3D mouse, that you use in conjunction with your existing mouse. Using the special controller cap on the SpaceNavigator you can twist, turn and rotate the 3D view of the board, all without needing to touch the standard mouse (http://www.3dconnexion.com/).
Board Insight – flexible view management tools

A complex-multi layer board makes for a visually dense and often difficult to interpret workspace. The new Board Insight system makes it easier to view and understand the objects in your design. The Board Insight system is an integrated set of features developed to meet your view management needs. It includes an Insight Lens, heads-up cursor information, floating graphical views, simplified net highlighting, and enhanced net labeling on objects.

**Insight Lens**

The new Insight Lens makes light work of performing a detailed examination of your board. While the workspace remains at a low level of zoom you can closely inspect the smallest detail on the board, magnifying it in the Insight Lens. With its own zoom and single layer shortcuts, working with the Insight Lens will soon become second nature. Shift+M turns the Lens on and off and Shift+N lets you park and retrieve it. Configure it in the PCB Editor – Board Insight Lens page of the Preferences dialog.

**Heads-Up display data**

The Heads-Up display gives you real-time feedback about objects currently under the cursor in the PCB workspace. The Heads-Up display is configurable, and can include cursor location, delta information (from the last mouse click), current layer and current-snap grid. As well as the information content, the display font and colors can also be configured.

Turn the head-up on or off using the Shift+H shortcut. You can park it anywhere on the screen using the Shift+G shortcut, and pick it up again using the same shortcut. This allows you to have it move with the cursor, or position it anywhere on the screen in a fixed location.

Configure the Heads-Up display feature in the PCB Editor – Board Insight Modes page of the Preferences dialog.

**Heads-Up Hover mode**

If you pause for a moment as you are moving the cursor, the Heads-Up display will switch to Hover mode. In Hover mode extra information is displayed, this can include a summary, available shortcuts, rule violations, net, component and primitive details. Configure your preferred set of Hover display options in the Preferences dialog.

**Popup mode**

The Board Insight system’s Popup view is an excellent tool for interrogating objects under the cursor. Shift+X opens the Popup, loaded with all components currently under the cursor. Shift+V opens it loaded with details of all violations currently under the cursor.

From the list you can Edit, Select or Zoom on any of the objects. The Board Insight list can include primitive objects, such as pads and tracks that belong to the components, nets and violations. The list is hierarchical, allowing you, for example, to drill down for complete detail on the objects.
Panel Mode

The Board Insight Panel provides the same information as the popup view, in a panel, with no keystrokes required to update the contents. When you hover over component, net or violation objects they are loaded into the panel, where you can edit them, change their selection state and navigate to them. The lower region of the panel includes the Board Insight Lens, giving you a close up view of the area currently under the cursor.

The Board Insight panel works like any other panel – it can be resized, docked or floated over the workspace. The information in the panel is updated after briefly pausing the cursor. Once the information is in the panel it will remain until the cursor is paused in a new location. You can edit the objects, change their selection state and navigate to them from this mode.

Enhanced Visual PickList

A multi-layer PCB is a dense and visually crowded workspace, with many objects on top of one another. The enhanced Visual PickList makes object selection simple. When the cursor is clicked (or double-clicked) and there are multiple objects under the cursor the Visual PickList will appear, as you move the mouse through the list the current object will select on the board, as well as being displayed in the floating view port, allowing for easy identification. The objects in the PickList are also sorted by layer.

Displaying net names on tracks

Have you ever wanted to be able to easily ‘read’ your design? Sure you can tell which component is which, but until now the routing gives you no feedback, appearing as a dense collection of unlabelled tracks. As part of the new Board Insight system each track now displays its net name, another handy Insight into your PCB design.

Live Net Highlighting

Making sense of complex PCB designs has been made even easier with the new Live Highlighting feature. Simply hold the Shift key to enable the Live Highlighting mode, then as you hover over a net all objects, on every layer, are intelligently highlighted. Add Ctrl to highlight all nets in a net class.

Live Highlighting is configured in the PCB Editor – Board Insight page of the Preferences dialog.
Enhanced single-layer display with gray-scale

A popular feature with Altium Designer 6’s PCB editor is the single layer display mode. A press on the Shift+S shortcut hides all display layers except the current layer, instantly de-cluttering your view to only show the objects on the layer you are working on.

Single layer mode has been enhanced by the addition of 2 new options, allowing you to retain other layer data in your view, except displaying it without color. Converting all other layer colors to grayscale or monochrome lets you retain the spatial relationship information about the location of other objects in the design, without distracting you from the layer of interest.

Control these new options using the Background intensity slider under the Mask Level button in the PCB workspace.

Single layer mode behavior is configured in the PCB – Board Insight Display page of the Preferences dialog. By default, all 3 single layer display modes are enabled, meaning that you will cycle through them as you press Shift+S.

Single layer mode also supports blind and buried vias, ensuring that the display accurately represents the via copper on the active layer.

Layer sets and set manager

A typical board design could include 8 signal layers, 4 plane layers and 10 mechanical layers, as well as the top and bottom silkscreen and ancillary layers, such as solder and paste masks. Layer sets are an ideal way of managing the display of this large number of layers.

PCB layer sets can be defined in the Layer Sets Manager dialog. Any number of layer sets can be defined, and each can include any of the layers available in the board design.

To toggle the workspace to display a different set of layers, use the Layer Set control at the bottom left of the workspace. The popup menu will automatically present your current list of Layer Sets. Include the & character in the Layer Set Name to define the following character as an accelerator key.
PCB layer tabs and layer navigation

Moving around a large or complex design can often mean lots of layer switching. You’ll appreciate the improved PCB Layer tabs in Altium Designer 6, that will help you better manage, navigate and inspect layers in your design.

Layer Tab and navigation enhancements include:

- Color-coded Layer tabs allow easier identification of layers and their content.
- Current layer name can be bolded for quicker identification.
- Shortened layer names on tabs can give you more control over managing your space with less scrolling and searching for hidden layer tabs.
- Commonly-used commands for layer-related dialogs available through right-click menu.
- Layer visibility adjusted through right-click, Show Layers and Hide Layers, menu commands.
- Layer highlighting using the same shortcuts as net highlighting (Ctrl+Click for layer, Ctrl+Shift+Click for multiple layers, Ctrl+Alt+Mouse to highlight layer tab under cursor).
- Layer navigation with the mouse wheel – hold Ctrl+Shift as you roll the wheel to change the active layer.

![Figure 28. Layers can be highlighted through right-click menu commands as shown here, or through shortcut keys on the layer tabs (Ctrl+Click highlights layer content, Ctrl+Shift+Click increments highlighting, and Ctrl+Alt+Mouse hovers highlight layer).](image)
Substantial polygon improvements

Polygons are a core design object on a modern PCB. It is not uncommon for a multi-layer board design to include 50 or more polygons, used for power planes, and to fatten up high-current routing. Altium Designer 6 includes a number of enhanced and new polygon capabilities. Named polygons makes it easier to configure polygon-type design rules. Faster polygon pour performance improves your design productivity, and the Polygon Manager gives you a complete overview of all polygons on the board.

Manage all polygons in the Polygon Manager

The new Polygon Manager provides a powerful control center for reviewing and managing all of the polygons on a board. The Polygon Manager is launched from the Tools » Polygon Pours submenu.

Figure 29. Polygon manager allows you to review and manage all polygons on the board.

The Polygon Manager not only provides a high-level view of all polygons on the entire board, with it you can:

- Name or rename each polygon.
- Set the pour order of polygons.
- Perform actions on selected polygons, such as repour or shelve (hide from display and DRC).
- Add and scope design rules for selected polygons.

Polygon panel

Providing an alternate method of reviewing polygons across the board, the PCB editor panel now includes a Polygon mode. Not only does it allow you to examine and edit a polygon, it also details the objects that make up the polygon.

Standardized polygon placement behavior

Previously, polygon corner mode behavior differed from standard track placement behavior. Simplifying and improving the editing process, Altium Designer 6 normalizes polygon corner modes to behave the same as track placement corner modes – press Shift+Space to cycle corner styles and press Space to toggle the corner direction.
Polygon edge sliding

Altium Designer allows you to reshape a polygon by moving the vertices. Altium Designer 6 extends your reshaping capabilities with polygon edge sliding – simply click and hold on the edge after launching the Move » Polygon Vertices command to slide the edge, while maintaining its current angle.

These placement and editing techniques apply to all polygonal objects, including regions, cutout regions, component bodies, polygon rooms and the board outline.

Improved polygon connectivity and speed

Appreciating the importance of working with polygons in the board design process, Altium Designer 6 delivers enhancements to polygon connectivity and polygon pouring speeds.

This includes:
- Full support for connectivity between polygons and vias. Vias can be directly connected or thermally connected to polygons. Opening an older format file will warn of potential connection changes.
- Polygon pouring speed has been substantially improved.
- Polygon graphics performance has been improved. This benefit is delivered in both the existing and new graphics engine.

Define polygon shape from selected objects

You can create company logos or polygons easily from external sources (i.e., DXF or AutoCAD®) using Define a polygon from selected objects in the PCB editor.

To define a polygon from selected objects first select the objects, then switch to a different layer, then launch the Tools » Polygon Pours » Define from selected objects command to create a polygon on the current layer.

Polygons are created as an outline only, edit them and set the fill mode as required.

Figure 31. Standardized polygon placement behavior gives greater control when placing and editing polygons. The new edge sliding feature, available in the Move » Polygon Vertices mode, supports sliding both straight and arc style edges.

Figure 32. Via-to-polygon connections are now controlled by design rules, here 2 are relief connected and 1 is direct connected.

Figure 33. Creating a polygon from selected objects. Source objects have been imported to a copper layer and selected with the Select Connected Copper command, with the polygons being created on the current layer (Top Overlay).
Enhanced pad options – slotted/square holes and rounded rectangle shape

The new Pad dialog gives a complete and accurate view of the pad being edited. The preview window includes layer tabs so you can easily examine the pad shape on any specific layer.

Altium Designer 6 supports slotted and square holes in PCB pads. Defined in the redesigned PCB Pad dialog, you have immediate visual feedback on the design of the pad. Altium Designer 6 also supports a new pad shape, Rounded Rectangle. The rounding corner radius can be set from zero to 100%.

Support for slotted/square holes includes:
- Round ended (NC routed) slotted holes.
- Square (punched) holes.
- Plated or un-plated slotted and square holes
- Separate drill files (NC Drill Excellon format 2) are generated for each hole kind (round, square, slot), as well as for plated and non-plated (up to 6 different drill files).
- Full support for power plane connections and clearances.

Enhanced drill table

Altium Designer 6’s support for slotted holes in PCB pads includes the addition of slot information in the Drill Drawing Symbols table – providing more options for board fabrication and smoothing the process to manufacturing. Appropriate slot information is included at the time of output file generation.

Improvements for slotted holes in the Drill Drawing include:
- Support for extended numbers of symbols, and automatic switching to letters when the graphic symbols run out.
- Letter symbols now support an extended sequence (A…Z, AA, AB, etc.).

Reworked for greater overall presentation, the Drill Drawing Symbols table features the addition of headers and column separators. Symbols are drawn in the table at the same height as the rest of the table text for improved legibility. This allows for a clearer drill drawing utilizing small symbols.
A new **Hole Size Editor** mode has been added to the PCB panel, giving you complete visibility and management of all drill sizes on your board. Various criteria can be defined in the panel to allow you to zero-in on and display only holes of interest. These criteria allow you to consider only:

- Holes associated with pads and/or vias.
- Plated and/or non-plated holes.
- Holes associated with pads/vias that are part of a component and/or free.
- All hole types, or only round, square or slotted holes.
- Selected and/or unselected holes.
- Only the layer-pairs of interest.

Once the criteria are defined, the panel lists all unique hole definitions, and the pads and/or vias associated with each. Click on a **Unique Hole** entry to view all instances of that hole in the design.

A hole entry can be edited directly in the panel. Simply click in the relevant field to edit the hole’s Size, Length, Type and whether it is to be plated or not. Pad or via properties can also be edited by double-click on an entry to open the associated **Properties** dialog.

### Table: Hole Size Information

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Tool Size</th>
<th>Physical Length</th>
<th>Round Path Length</th>
<th>Plated Hole Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>HC</td>
<td>1.5mm</td>
<td>(10.746mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>MB</td>
<td>1.5mm</td>
<td>(10.746mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>AF</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>AF</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>G</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>H</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>N</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>O</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>Q</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>V</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>S</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>D</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
<tr>
<td>B</td>
<td>1.5mm</td>
<td>(11.091mm)</td>
<td>1.4mm (&lt;55.110mm)</td>
<td>PTH Round</td>
</tr>
</tbody>
</table>

**Note:** Physical Length = Round Path Length + Tool Size + Slot Length as defined in the PCB layout.
PCB panels from an Embedded board array

PCB Panelizing can be performed by your fabricator, but there are often reasons you need to do this yourself. Altium Designer 6’s PCB editor supports PCB panelization with the Embedded Board Array feature, which supports:

- Creating a panel of different boards
- Rotating and flipping boards in the panel
- Boards in the panel are referenced back to the original PCB file (rather than copying the PCB data), allowing immediate panel updates when one of the board design changes

Altium Designer 6 strengthens the PCB embedded board array, with the addition of comprehensive stackup checking and reporting.

Stackup Compatibility report

The new Stackup Compatibility report gives immediate feedback on the layer stackup of each board in the panel, against the layer stackup defined for the panel itself. At the bottom of the report there are hyperlinks to open the Layer Stackup dialog of each board, so you can examine the stackup and determine how to resolve a stackup incompatibility.

A warning dialog will automatically offer to open the report if you attempt to generate output from a panel that has stackup compatibility issues. The Gerber and ODB++ dialogs also detail any stackup compatibility issues.

Stackup Compatibility report

**Figure 37. Boards can be flipped and rotated in an embedded panel.**

<table>
<thead>
<tr>
<th>panel</th>
<th>NBP32</th>
<th>NBP32 (Flipped)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Layer (Signal)</td>
<td>Top Layer (Signal)</td>
<td>Bottom Layer (Signal)</td>
</tr>
<tr>
<td>MidLayer1 (Signal)</td>
<td>MidLayer1 (Signal)</td>
<td>MidLayer4 (Signal)</td>
</tr>
<tr>
<td>InternalPlane1 (Plane)</td>
<td>Gnd (Plane)</td>
<td>MidLayer3 (Signal)</td>
</tr>
<tr>
<td>MidLayer2 (Signal)</td>
<td>MidLayer2 (Signal)</td>
<td>VCC (Plane)</td>
</tr>
<tr>
<td>InternalPlane2 (Plane)</td>
<td>VCC (Plane)</td>
<td>MidLayer2 (Signal)</td>
</tr>
<tr>
<td>MidLayer3 (Signal)</td>
<td>MidLayer3 (Signal)</td>
<td>Gnd (Plane)</td>
</tr>
<tr>
<td>MidLayer4 (Signal)</td>
<td>MidLayer4 (Signal)</td>
<td>MidLayer1 (Signal)</td>
</tr>
<tr>
<td>Bottom Layer (Signal)</td>
<td>Bottom Layer (Signal)</td>
<td>Top Layer (Signal)</td>
</tr>
</tbody>
</table>

**Figure 38. The Stackup Compatibility report shows incompatible layers in red and the total count of violations at the top of the report.**
**PCB editor TrueType font support**

The PCB editor now has full support for TrueType® fonts. This gives you access to all the TrueType fonts available on your PC, including Unicode-character sets, such as Japanese. Place your company or product name in your preferred font and give your board the high-quality look it deserves.

All PCB text strings can be set to one of the PCB editor’s 3 built-in fonts, or to a TrueType font available on the PC. As well as Bold and Italic, TrueType strings can also be inverted, ideal when you need to present a string in a copper layer.

Fonts can be embedded in the PCB file by enabling the **Embed TrueType fonts** option in the **Preferences** dialog. If a TrueType font is not embedded and the font is not available when the file is reopened on a different PC, the specified alternate system font will be used in its place.

Polygon and layer polarity features of Gerber and ODB++ are used to give full support of TrueType, inverted TrueType and barcode strings through to fabrication.

**Inverted text**

Also available in the **String** properties dialog of the PCB editor, text can be inverted when TrueType fonts are being used. You can specify a fixed border width along each edge of the string, or a user-defined inverted rectangle, with the string justified to any edge within the rectangle.

Inverted text for TrueType fonts behaves the same as normal text for design rule checking, based on the string’s bounding rectangle.

Inverted text can be used on copper layers, including within a polygon. For the string to appear etched into the polygon, include suitable Clearance Constraint and Short Circuit constraint design rules to allow the polygon to be poured right up to the string’s inverted rectangle.

**Place barcodes on the PCB**

Barcodes are commonly used to tag and identify PCBs. Altium Designer 6 allows you to place barcode symbols directly onto any PCB layer, allowing barcodes to be easily imprinted on a PCB as part of the manufacturing process.

The **Barcode** option is enabled in the **String** dialog. Simply enter or paste the appropriate barcode string into the Text field, and enable the Barcode option. Barcodes can also be inverted.

---

*Figure 39. Use the new TrueType font support to display text in your preferred font face, including your local language, such as Japanese, as shown here. Text can also be inverted, and barcodes can also be defined via the String dialog.*
Paste metafile onto a PCB

The generation of design documentation is enhanced with Altium Designer 6’s ability to paste metafile data onto a PCB. Using the same Windows Paste command that you are used to (Ctrl+V), metafile data from the clipboard can be pasted in the PCB editor.

Supported metafile data includes: bitmaps, lines, arcs, simple fills, and true type text. All data will be pasted onto the current layer, adopting the color you have chosen for that layer. After pasting, right click and use the Resize Union command to fine tune the size of the pasted image. Control the paste format in the PCB Editor – General page of the Preferences dialog.

Relative visible and electrical grids

Appreciating that you may have to change through a large range of snap settings during the board layout process, the Visible and Electrical Grid options can now be set relative to the Snap Grid – offering excellent visual feedback of your current snap grid setting.

Move selected objects with arrow keys

Perhaps the single thing most needed for productivity in any design environment is to have often-used commands and capabilities readily available. Controlling objects in both the PCB and schematic editors has been enhanced by the support for move selected objects using only the arrow keys. Simply select one or more objects, then hold Ctrl key and press the arrow keys to move the selected objects. Include the Shift key to move them in increments of 10x the grid.

Move by X, Y offset

Another one of those small features you’ve always wished you had, Altium Designer 6 includes a Move Selection by X,Y Offset command. An Ideal tool for precisely repositioning a section of the board, the command is available in the Move sub-menu. This command is also available in Altium Designer 6’s schematic editor.

Figure 40. Tables, paragraphs of text and simple diagrams created in Microsoft® Word or Excel can be brought into the PCB editor.

Figure 41. Available from Design » Board Options in the PCB editor, you can set the required format as a real number multiple of the Snap Grid (i.e., 1.5).

Figure 42. Define the X and Y offset amounts in the Move Selection dialog.
Reposition selected components

Extending the integration between the capture and layout stages of design, the Reposition Selected Components command allows you to position components on the PCB, in the same order they were selected in the schematic.

Once the components have been selected on the schematic, switch to the PCB editor and launch the Tools » Component Placement Reposition Selected Components command. The components will appear on the cursor one-by-one, ready to be positioned on the board.

Display the component reference point

The reference point of each component can be displayed in the PCB editor by enabling the option in the Display page of the Preferences dialog. You can also define the color of the reference marker.

Figure 43. Reposition selected components is also compatible with and supports the cross-select functionality between the schematic and PCB editors.

Figure 44. Enable the display of the Component Reference Point in the Preferences dialog.
3. Create great designs without constraints – shaping the modern board

Today’s compact and dense electronic products demand that the board designer work with a creative board shape, and achieve unusual component mounting solutions. It also means that the placed board must be available for the mechanical engineer to load into the case design, in their preferred MCAD tool.

Altium Designer 6 supports complex board shapes, which can be defined from imported DXF/DWG data. Board shapes can also include cutouts. Components can be mounted over other components with confidence, using the component body objects to monitor Z-plane clearance requirements. And for full ECAD to MCAD design transfer there is support for STEP component models, as well as STEP export of the completed board.

Backed up by the improved DXF/DWG, IDF and IGES support, you’ll appreciate the tight ECAD-to-MCAD design integration that you can achieve in Altium Designer 6.

Complete coverage for modeling the components

Altium Designer 6 delivers strong support for modeling the components on your board – and then exporting the completed board to an MCAD tool. On any board there will be a mix of dimensionally critical components, such as connectors, displays and switches that need to interface to the product case. There will also be components that can be represented by an approximate model, such as ICs. Since 3 dimensional mechanical models may not be readily available for all components, it is important that you have workable alternatives.

Altium Designer 6 delivers this, with 3 levels of component modeling support:

- **Inferred models** – component models predicted by Altium Designer 6, from the footprint properties and the component designator. Thru-hole and surface mount ICs are typically well supported by this modeling option.
- **Component bodies** – by including multiple component body objects in the footprint, you can model most component shapes. Use these when the inferred model is not suitable, or you have accurate dimensional requirements to meet, but a true mechanical model is not available.
- **Imported models** – STEP, VRML and IGES format models can be imported into Altium Designer 6.

*Figure 45. Altium Designer’s 3D view of a board, using a mixture of models. The display, connectors and switches are STEP models, the ICs are inferred models, and the small gray box is a crystal oscillator, created from component body objects.*
Import of STEP models

Figure 46. There are a growing number of STEP format component models available, from sites such as 3DContentCentral.

STEP, the STandard for the Exchange of Product model data is becoming a preferred standard for ECAD to MCAD data exchange – allowing transfer of 3D models between CAD applications. Altium Designer 6 has strong support for STEP – the model data is not translated into an internal format, instead it remains as STEP data right through to the exported STEP board file.

STEP export

The 3D Viewer in Altium Designer 6 supports export to STEP. All model types are exported into the STEP file, giving you an accurate 3 dimensional description of the completed board, ready to load into your preferred MCAD tool. You have full control over the level of board detail included in the STEP file, such as copper, silkscreen, strings and holes.

Figure 47. The exported STEP board file loaded into your preferred MCAD tool.
Improved IDF and IGES export

Altium Designer 6 supports other MCAD transfer formats, including IDF export from the PCB editor, and IGES export from the 3D Viewer. Both have been greatly improved with smaller exported files, making them easier to import into your MCAD environment.

Enhanced DXF/DWG Interface

DXF and DWG are popular file formats for transferring data between design tools, particularly for transferring the board outline from an MCAD tool into Altium Designer. DXF/DWG export has been enhanced by new controls that allow exporting selected objects with zero line widths, ideal when the data is to become part of a dimensioned mechanical drawing. DXF/DWG import has also been enhanced, you can now apply scaling, define the default line width, and specify the insertion location.

Define Cutouts in the board

Board Cutouts are a new capability for the PCB editor and allow a Region to display a Board Cutout. A new option in the Place » Solid Region dialog allows you to define a region as a board cutout.

Board Cutouts are supported for fabrication as well. Board cutout routing paths are outputted both in Gerber and ODB++.
4. Design documentation linked to everyone in your organization

There is more to a completed board design than the fabrication files. The Bill of Materials, the manufacturing and assembly drawings, and the product manuals are just some of the documentation needed to get your product into the market.

PDF is the universal electronic document viewing format, used across all industries. In support of the widespread need to output electronic documents in the PDF format, Altium Designer now includes built-in PDF publishing capabilities, directly from an Output Job file.

Altium Designer 6 builds on its strong documentation support with capabilities that let you include design parameters, PCB data, and database information, into the BOM. The BOM can be loaded straight into your latest company Excel template.

The improved bill of materials capabilities are backed up by enhanced Windows clipboard support, letting you achieve a new level of detail in your design documentation. You can copy a snapshot of the board onto the Windows clipboard for the product manual, or paste tabular or graphical information onto the schematic.

Altium Designer 6’s improved documentation capabilities will help you deliver better documentation, in less time.

Enhanced Excel BOM and report generation

Altium Designer’s report generator is a powerful and flexible reporting engine. As well as generating the BOM, it’s flexible formatting and output capabilities mean it can be used to generate any type or report needed from the project. A number of improvements have been made to the report generator in Altium Designer 6, ensuring that you can generate exactly the output you require, with the minimum of fuss and effort.

Include project parameters and the PCB file name

Parameters are a universal feature of Altium Designer and can be added to the project, a document, a component and other objects. Project and document parameters can now be extracted from the design and included in your report, such as the BOM.

Figure 50. If project parameter Names are defined as Fields in the Excel template, the generated BOM will includes the parameter Values.

Two new parameters have also been added in Altium Designer 6, to simplify the process of including the PCB file name in the report.

- Field=PCBDataSourceFullName – displays the full name of the PCB data source.
- Field=PCBDataSourceFileName – displays the file name of the PCB data source.
Include PCB data in reports

Schematic and PCB data can now be included in the same report file. You could, for example, use this when you need to generate a pick and place file that needs component parameters from the schematic, as well as location and rotation information from the board.

Figure 51. A pick and place report configured in the Report Manager dialog, with the Include Parameters From PCB option enable.

Include database data in reports

It is common practice to link the Altium Designer components back to your company database. As well as extracting and including database information on the schematic, you can also include database information directly in the BOM, ideal for data that is important for the procurement and manufacturing process, but is not needed on the schematic.

Figure 52. The Bill of Materials, with the Include Parameters From Database option enable.
Publish to PDF

PDF is the universal electronic document viewing format, used across all industries. In support of the widespread need to output electronic documents in the PDF format, Altium Designer now includes a generic Publish to PDF capability.

Configured and run via an Output Job file, any number of Schematic, OpenBus, PCB and PCB3D print-type outputs can be combined together into a single PDF document. PDF bookmarks are created for each output, and all of their corresponding components, nets, pins and ports. The Publish to PDF can also be driven from a script, allowing you to create a pre-packed command to generate a PDF of a standard set of outputs.

**Source Files**

- Schematic
- OpenBus
- PCB
- PCB3D

**Output Job Editor**

**PDF**

Figure 53. Publish to PDF allows you to build custom PDF documents from a number of different source files that can be configured to include both logical and physical representations of your design as well as different page sizes and orientations.

PCB editor copy to Windows clipboard

Figure 54. Copy a selection from the PCB editor onto the Windows clipboard, and then paste directly into another application.

Another invaluable documentation feature that compliments the support for pasting from the Windows clipboard, is Altium Designer 6’s ability to copy from the PCB editor to the Windows clipboard. Not only can you copy selected objects as a vector format graphic, such as the top side components shown in the image above, you can also copy the selection as text. Altium Designer 6 will intelligently interpret the selected data and load descriptive information onto the clipboard.

XML PCB reports

PCB reports can now be generated in a variety of formats, including the original text format, HTML and XML. Open the Reports page of the Preferences dialog to configure the reports. All reports are actually generated in XML, and then an appropriate XSL (Extensible Stylesheet Language) transformation is applied to create the output in the required format. You can also select your own XSL transformation file, use this capability to present the report in your company’s preferred format.

**Figure 55. An HTML style DRC report, with hyperlinks to the violations.**
Pasting external or internal information onto schematic sheets

Altium Designer 6 brings full graphical clipboard support to the schematic editor. This support means you can perform a copy in virtually any Windows application, such as PowerPoint, Excel, Visio, or your preferred technical or graphical application, and paste the results onto your schematic.

All layout and formatting applied in the original application is retained, greatly improving the quality of documentation you can generate from the system.

The data in the Windows clipboard can be either in Metafile format (to keep graphical information, such as Excel data), or plain text, ready to paste into a note or text-frame, or even paste as a set of ports or net labels, using the Altium Designer 6 Smart Paste feature.

![Figure 56. Paste graphical information directly from the clipboard onto a schematic, either from another application, or from an Altium Designer 6 grid control, including any panel or dialog with a table-like design.](image)

Copying reports into schematic sheets

All Altium Designer 6 grid controls have also been upgraded to support a Windows metafile-type copy to the clipboard. This allows the content of any grid control to be copied and then pasted directly into another application, such as Excel, or onto a schematic sheet. This allows you to easily add information to schematic sheets from almost anywhere in the software, including the BOM or the Design Rules, for example.

Use the Windows standard shortcuts to select and copy content from the grid controls (Ctrl+A to select all, Ctrl+C to copy, Ctrl+Click to cumulatively select).
5. Integrate and manage libraries – protect and re-use your valuable component IP

Your component libraries sit at the core of your design and development process. They are also an integral element of the product procurement and manufacturing process. Strengthening the component management functionality has been a central focus of the improvements made in the Altium Designer 6 releases.

The ideal component management solution is to integrate all component specifications into a single, central company database. That way the one component record can detail everything from the parts pin, to the supplier, the approval status, the datasheet, right down to the Altium Designer 6 symbol and footprint. Altium Designer 6 database libraries deliver this capability, effectively allowing you to browse and place directly from a company database, right onto your schematic.

Altium Designer 6 also includes a broad range of IPC libraries, and a new IPC footprint wizard that greatly simplifies the footprint creation process. There are also new tools for reviewing and updating footprints across the entire design.

Full database-driven part libraries

Component libraries can now be constructed with all symbol reference, model linking and parameter information stored in an ODBC or ADO based database, or an Excel spreadsheet. Each record in the database represents a component, storing all of the parameters, along with links to the models. The record can include links to inventory or other corporate component data.

With this approach the Altium Designer schematic component is only used as a symbol, with the models (footprint, 3D Model and simulation model) stored in standard library and model files. The interface between the company database and Altium Designer 6 is a Database Library document. The Database Library, or DBLib, is added to and presents like any other library in the Altium Designer Libraries panel – you can browse the list of components, examine the component symbol and its models, and place the component.

![Database Library](image)

Figure 57. When you place from a DBLib all the component information comes directly from your database.

Behind the DBLib that you are browsing in the Libraries panel is your database, each component in the panel corresponding to a record in the database. As well as company type data, such as cost or stock number, the database will also specify the Altium
Designer schematic symbol, the footprint, and other models that are part of the component. When you click the **Place** button in the **Libraries** panel the symbol is extracted from the specified Schematic library, and component properties, such as the footprint and chosen component parameters, are added as you place it on the sheet.

**Integrated library to database library translation Wizard**

Altium Designer 6 includes a new Library Translation Wizard, ideal for converting your company Integrated Libraries into the new Database Library structure. With a DBLib document open, Launched from the DBLib **Tools** menu, the Wizard will decompile the integrated libraries and build database tables, complete with parameter and model information extracted from the components. You can then remove all parameter and model information from the symbols, and configure the DBLib document to reference the appropriate database columns.

**Flexible component management with smart component identification**

When you place a component from a library there is value in the design software remembering which library that component came from, giving you history and traceability for the component. But this memory can be a double-edged sword, working against you in some circumstances. Perhaps you need to take your design home and work from a local copy of the company library. Or the organization of your libraries might have changed, with your current project’s components now coming from a different library. These situations make it difficult to perform an update components from libraries command, if you are not able to make the original source libraries available.

Altium Designer 6 gives you the best of both worlds, each component continues to remember its source library name, but you have a set of options that give you control over that reference. This smarter and more flexible approach for managing your component-to-library relationships is called **Smart Component Identification**. It offers both the flexibility and control to be able to easily switch between locations of reference libraries, and identify and validate that you are using the correct components in your design.

**Levels of identification**

Smart Component Identification is a composite of three levels of component-to-library identification control:

- **Relative path installation for libraries** – configured in the **Available Libraries** dialog, libraries can have absolute or relative references, which make it possible to use portable libraries.

- **Changing the library name at the component level** – each component now includes a **Library Name** checkbox, if it is checked then the component must come from the named library, if it is unchecked then all available libraries are searched.

- **Changing table names from a DBLib** – for components place from a DBLib, the **Table Name** check box lets you enforce or release the component being tied to the specified table name.

**Figure 58. Here you see that Component A is the same component referenced in both Library A and Library B. You can change the Library Path, Library Name for a component, or Table Name for a DBLib component, to switch between the source components.**

**Figure 59. Enforce the Library Name and Table name in the Component Properties dialog.**
IPC compliant board-level libraries
Altium’s Library Development Center is developing a growing suite of IPC-7350 series footprint libraries.

- These footprints are supplied in both PCB footprint library format (*.PcbLib) and also used across the manufacturer-based integrated libraries (*.IntLib) included with Altium Designer, where appropriate.
- As specified in IPC-7351 and where applicable, each component has three footprint variants, denoted Nominal, Least and Maximum. Footprints are named with an identifying letter at the end of the name.
- As specified in IPC-7351, each footprint includes an Assembly layer (Mechanical13) and Courtyard layer (Mechanical15).

IPC footprint Wizard
Available through the Tools menu when a PCB library is the active document, the new IPC Footprint Wizard creates IPC-compliant component footprints. Rather than working from footprint dimensions, the IPC Footprint Wizard uses dimensional information from the component itself, in accordance with the standards released by the IPC. Currently the Wizard supports the following package types:

- Chip Components
- BGA (Ball Grid Array)
- QFN (Quad Flat Pack No-Lead)
- SOJ (Small Outline Package No-Lead)
- SOT23 (Small Outline Transistor, 3-Leads, 5-Leads and 6-Leads)
- SOT89 (Small Outline Transistor)
- SOT143/343 (Small Outline Transistor)
- SOT223 (Small Outline Transistor)
- CFP (Ceramic Dual Flat Pack)
- DPAK (Transistor Outline)
- Laminate CSP (QFN with 2 rows of pads)
- LCC (Leadless Chip Carrier)
- LLP (QFN with power bars)
- MOLDED (2-pin components, includes capacitor, diode, inductor)
- MELF (2-pin components, includes diode and resistor)
- BQFP (Bumpered Quad Flat Pack)
- PQFP (Plastic Quad Flat Pack, includes PQFP Exposed Pad)
- SOIC (Small Outline Integrated Package – Gullwing Leads, includes SOIC Exposed Pad)
- SOP (Small Outline Package – Gullwing Leads, includes SOP Exposed Pad)
- WIRE WOUND (Precision wire-wound inductor, 2-pins)

IPC footprint batch generator
Complementing the IPC Footprints Wizard, the IPC Footprints Batch Generator can be used to create an entire series of footprints. The batch generator is driven from a spreadsheet, once this is configured the batch generator reads the table and quickly builds a footprint library. Altium Designer 6 includes a number of spreadsheet templates that can be used as a starting point for the batch generator. There is also detailed documentation on the fields the batch generator requires for each package type, click the Help On button in the batch generator to access the documentation.
Footprint manager – manage footprints across the entire design

Altium Designer 6’s schematic editor includes a powerful **Footprint Manager**. The Footprint Manager lets you review all the footprints associated with every component, across the entire project.

The Footprint Manager makes it easy to review and detect problems with footprint assignments across the entire design, particularly useful when you are working on a legacy design, or one from another organization.

Multi-select support makes it easy to edit the footprint assignment for multiple components, change how the footprint is linked, or change the current footprint assignment for components that have multiple footprints assigned. Design changes are applied through Altium Designer’s standard ECO system, updating both the schematic and the PCB if required.

**Compare and update PCB components from libraries**

Altium Designer 6 includes an **Update from PCB Libraries** feature that will give you complete confidence that the footprints on the board exactly match those in the source libraries.

The Update command performs a full analysis and comparison of all objects in both the board and library version of each footprint, and details every difference. For each footprint that does not match, you can then select if that footprint is to be updated or not.

---

**Figure 62.** Manage footprint assignments across the entire project with the new Footprint Manager.

**Figure 63.** The new Update from PCB Libraries feature does a full comparison of every footprint used on the board and updates them from all source libraries.
6. Manage increased design complexity and be quicker to market

Not only are designs themselves becoming more complex, so are the needs of your company. Increasing competition and growing time to market pressures means you need your engineers to reduce the time spent on design file management, and focus more on the actual design development.

Signal Harnesses allow the design to be structured and presented in an uncluttered and logical fashion. Use them to bundle any combination of buses and nets, and greatly improve the readability of your schematics.

Design reuse also becomes a practical and realistic option with Altium Designer 6. Using Device Sheets you can store and easily re-use common sections of schematic circuitry, and also manage the assignment of designators. Assembly variants are an excellent feature for populating the one board design, differently, in multiple products. Variant support in Altium Designer 6 has been enhanced with new configuration capabilities that simplify setting up the variants, with flexible display capabilities that are sure to satisfy your printout requirements.

Altium Designer 6’s support for performing a project-level commit to your version control system means you can easily snapshot a revision of your board. Design re-use is another excellent approach to capitalizing on your wealth of existing designs. Altium Designer 6’s Snippet feature is a simple, yet highly effective method of capturing and re-using sections of your schematic and PCB designs.

Manage net and bus complexity with Signal Harnesses

Altium Designer 6 introduces a new way of establishing connectivity and reducing schematic complexity – called Signal Harnesses. Signal harnesses extend on bus and wire connectivity by allowing you to assemble logical groupings of any signals, greatly simplifying the wiring traffic, enhancing readability, and potentially streamlining the structure of your schematic design.

Using signal harnesses you can create and manipulate higher levels of abstraction between sub-circuits, effectively allowing for more complex designs to be represented with simpler drawings.

![Signal Harnesses Diagram](image)

Figure 64. Harnesses carry multiple signals and can include both busses and wires, which are grouped and then referenced as a single entity. This multi-signal connection is called a Signal Harness.

Signal Harnesses as a meta-bus

To use a harness as a container for nets / buses, you simply wire each net and bus into a Harness Entry in a Harness Connector. Each net or bus is identified in the harness by the name of the Harness Entry that you wire it to – it is that name (not the order of the Entries) that is used by Altium Designer to establish connectivity throughout the design. Note that the Harness Entry name is not used to name the net, unless you name the Signal Harness.

Recycling a Signal Harnesses

You can think of a Signal Harness as being like a physical cable. NewHarness, shown in Figure 64, would be the 3 wires (COL, CRS, and TXEN), and the twisted bundle of 4 wires (RXD[3..0]). And just like a cable, the harness does not care what signals you ultimately run through it. This means you can use the same signal harness multiple times in your design.
Inside a Signal Harness

The set of nets / buses that a Signal Harness can carry is specified by a Harness Definition. Whenever you place or edit a Harness Connector, Altium Designer automatically creates / edits a matching Harness Definition, in a Harness Definition file (*.Harness), as shown in Figure 64.

Nested Harnesses

Harnesses can also be nested, that is, a harness can become part of another harness. Figure 66 shows nested harnesses, where the 2 JTAG signal harnesses become part of the parent signal harness, HARDSOFT_JTAG.

Harnesses are nested by placing and wiring in the same way as wires and buses. Note that the Harness lines are optional. Any mix of Harnesses, Wires and Buses can be Harnessed together.

Defining a Harness without a Harness Connector

You can also define and use Signal Harnesses without placing Harness Connectors. In this case, you must create and manage the Harness Definitions yourself. You should also lock these Harness Definitions (using the Locked; keyword), so that Altium Designer does not attempt to modify or delete them as it automatically manages Harness Definitions created by the presence of Harness Connectors.

Figure 66. Harnesses can be nested together with other nets, buses and harness, into a parent harness.

Figure 65. Signal Harnesses can greatly simplify the visual complexity of a design. Both of these images show the top sheet from the same design, the upper version using Nets and Buses, the lower one using Signal Harnesses.

Figure 67. Signal Harnesses can also be created without Harness Connectors.
Flexible design reuse with Device Sheets

A long-held dream of most hardware engineers is a practical and viable method of being able to store and re-use standard sections of circuitry that are used in more than one product.

Device Sheets offer this. Based on standard schematic sheets, Device Sheets are placed in the design as a logical block, and wired in the normal way. Enhanced annotation capabilities ensure that the PCB has unique component designators, without requiring the Device Sheets to be re-annotated, or modified in any way.

What is a Device Sheet, and how are they used?

A Device Sheet is a standard schematic sheet, stored in a specified Device Sheet location. It is the way you include the sheet in the project that lets Altium Designer 6 know that you want it referenced as a Device Sheet, rather than as a linked schematic.

Instead of adding the schematic to the project, you Place » Device Sheet Symbol, using the Select Device Sheet dialog. The location where the Device Sheets are stored can be specified in the Device Sheets page of the Preferences dialog, or via the button at the bottom of the Select Device Sheet dialog.

The sheet symbol will automatically include sheet entries to match all ports in the Device Sheet. Once you have compiled the project the Device Sheet will appear in the Project hierarchy. The sheet symbol and the icon in the project tree are displayed differently, indicating that the sheet is a Device Sheet.

Once a Device Sheet symbol is placed, it is wired up in the normal way. When you open the Device Sheet itself as part of your project, it will display read-only and recycled watermarks. These are on-screen effects only, which can be configured in the Device Sheets page of the Preferences dialog. There is also an option to automatically make Device Sheets read-only files, ideal if the sheets are a central resource that are not allowed to be generally edited.

![Select Device Sheet dialog](image)

Figure 68. Device Sheets are included in your design via the Select Device Sheet dialog.

![Device Sheet symbols](image)

Figure 69. Device Sheet symbols are displayed using a special shape and graphic, that indicates that this section of circuitry is being re-used. Note that the Projects panel also uses a special icon to indicate if a sheet is a Device Sheet – this project has 5 Device Sheets in it.
Annotating a design that includes Device Sheets

Since a Device Sheet is a central resource that can be used in many designs, the design environment must support the unique annotation of the components in a device sheet, without modifying the original schematic. Altium Designer does this, with the introduction of the Board Level Annotate feature.

If the design includes Device Sheets, then it is annotated in a 2-stage process. Schematic level, or logical annotation is performed first, this ensures that all the components on non-Device Sheet schematics have a sensible logical designator, U? becomes U3, and so on. The Annotate Schematic command, along with the other annotation commands like Reset Schematic Designators, will not affect the components on the Device Sheets. These sheets are automatically excluded from the logical annotation process, and do not appear in the Annotate dialog.

Board Level Annotation

Board level annotation is essentially a second layer of annotation, which you can think of as being a physical annotation process. Board level annotation ensures that not only does every component have a sensible designator, but it is also a unique designator, across the entire design. This separate annotation process is necessary to be able to annotate the components on the Device Sheet, without altering the original schematic stored on your company’s server.

Altium Designer automatically manages the designator mapping, storing the information in a .Annotation file in the project. The original schematic can be viewed at any time by selecting the Editor Tab at the bottom of the workspace. There will also be a Tab for each physical instance of this sheet in the design. The logical and physical designator assignments are also displayed on both Tabs, you can control this display in the Device Sheets page of the Preferences dialog.

Not only does the board level annotation feature deliver a mechanism to annotate a design that includes Device Sheets, it also supports the flat annotation of multi-channel designs. Now it is possible to perform a positional, board level re-annotation of a multi-channel design, and pass those designator changes back to the schematic.

Figure 70. Once a board level annotation has been performed, the designator assigned to each physical component is shown on the compiled view Tab (selected at the bottom of the workspace). The original designators on the Device Sheet are shown in superscript.

Figure 71. Board level annotation means that multi-channel designs can now be annotated using a variety of schemes, including a flat annotation scheme.
Comprehensive assembly variant management capabilities

Appreciating the importance of assembly variants, Altium Designer 6 brings new commands and capabilities to the Assembly Variant Management dialog, giving superior variant management capabilities. Right-click in the dialog to access the commands, or use the Menu button.

- The Only Show Varied Components command makes it easy to examine the differences between variants.
- The Update Values from Library command supports quickly updating all parameters for the selected components from another library component, in a single operation.
- You can now set the variant configuration for components from the schematic sheet (right click on selected schematic components and choose Assembly Variants from the Part Actions menu, then use the Set Selected As Not Fitted command in the Variant Management dialog).
- Generate a detailed report of parameter variations (Menu button).
- Copy and paste an entire variant.
- Select and edit multiple variant fittings simultaneously.
- Variant information is preserved during re-annotation.

Figure 72. Enhanced variant management with the new right-click (or Menu button) commands.
Flexible variant printing features

Altium Designer 6 also brings substantial improvements in both on-screen display and variant printing. Select Variant Drawing Style via the Menu button to configure how you would like the varied components to be presented.

Figure 73. New options for handling the display and printing of not-fitted components.

Variant display and printing enhancements include:

- Multiple schematic and PCB display / print options for not-fitted components.
- BOM file name format supports display of variant names in the following format: <Bill of Materials> <Project Name> (<Variant Name>).
- Variant selection can be performed from the OutJob editor, or within the BOM Report Manager dialog.
- Smart PDF and schematic output jobs support printing of physical documents that include variant information, including alternate value components, and not-fitted components.

Figure 74. Select the assembly variant as part of the Smart PDF setup options.
**Parametric hierarchical design**

Hierarchical design is one of the outstanding strengths of Altium Designer 6, allowing you to structure your design in a logical and meaningful fashion. Altium Designer’s hierarchical design capabilities are not just for structuring the design though, they are also the backbone of the multi-channel design capabilities, and also makes it very easy to reuse a section of circuitry in different electronic product designs.

The challenge with reusing a section of design, for example pointing from a sheet symbol on your current project to your company’s preferred power supply schematic, is that the values of the components are not always fixed from one design to the next. The new support for parametric hierarchical design solves this – it allows you to move the specification of the component values from the schematic sheet, into the sheet symbol that references that sheet. This capability also works in perfectly with multi-channel design (designs where the same section of circuitry is repeated), allowing you to have different component values in each channel.

Parametric components are defined by declaring their value as a parameter of the sheet symbol above, and then referencing that parameter on the target component.

![Image](image-url)

*Figure 75. A graphic equalizer with different capacitor values in each channel.*

For example, a graphic equalizer can have the same circuit repeated many times, with the only difference between each channel being the component values. So a capacitor might take the values 0.12\(\mu\)F, 0.056\(\mu\)F, and 0.033\(\mu\)F in the different channels. Implementing this in Altium Designer is now simple since you can specify these values in the sheet symbol referencing each channel, eliminating the need to have many similar schematics with only component values being different.

Parametric hierarchy is not limited to component values; you can parametrically reference any component parameter or any text label on the schematic sheet. Another powerful feature of the system is that you can refer to parameters from a symbol that is many sheets up in the hierarchy; the system will search the hierarchy until it finds the matching parameter.
Tight Version Control integration

Version control is becoming the preferred method of managing design documentation, and Altium Designer’s strong version control system interface capabilities continue to improve.

Commit whole project

Modified project documents under version control can now be committed in a batch fashion, saving you time. **Commit Whole Project** is available from the right-click menu in both the Projects panel and the Storage Manager panel. Further options are defined in the Check-In to Version Control dialog.

This is an atomic commit in Subversion, resulting in a single revision – an excellent feature for tracking revisions of your product. For the other VCS systems that do not support atomic check-in, the files will be committed as a batch.

![Commit Whole Project](image)

Figure 76. Committing multiple modified files in a batch-style check-in using the Commit Whole Project command.

When committing your files, the Check-In to Version Control dialog can be configured to show not just the project documents, but documents in other folders as well. This is particularly useful for checking-in generated files that are not part of the project. In this mode, the list of files will be expanded to include:

- All files that are in a sub-folder of the project
- If there are project documents that are not in a sub-folder of the project, then all files in the same folder as those project documents will be added as well.
MatrixOne® PLM System support

Support has been added for using Enovia’s MatrixOne Product Lifecycle Management solution (PLM) as a Version Control System from Altium Designer 6.

Choose MatrixOne as your version control provider on the Version Control – General page of the Preferences dialog, and then work with it in the same way you work with other VCS tools.

![MatrixOne Preferences](image)

**Figure 77. Setting the version control Provider to be MatrixOne.**

Design Snippets – easy reuse of existing designs

If your designs often include sections of circuitry used in other designs, then you will make good use of the Design Snippets feature. A simple and easy to use feature, the Snippets system lets you save any selection of circuitry on a single schematic sheet, or any selection of a PCB design, including the components and the routing.

Schematic and PCB selections are saved as snippets in the new Snippets panel, right-click in the panel to add the current selection as a snippet.

Snippets can be organized into standard Windows folders on your network, click the Snippets Folders button to add an existing folder to the list of available folders in the Snippets panel. Each snippet is stored in a standard schematic or PCB file.

![Design Snippets panel](image)

**Figure 78. Right-click in the Snippets panel to add a snippet.**

Object Unions

Often you will want to work on a section of a design in a block-like fashion, for example during a design restructure. The enhanced Union feature is ideal for this, using it you can easily group any objects together as a Union.

Unions are created automatically for the objects in a schematic design Snippet, and you can select any set of schematic or PCB design objects and define them as a Union. When you click and hold to move an object in a union you will move all the objects in that union. Use the commands in the right-click Unions sub menu to create or reconfigure a Union.

![Object Unions](image)
7. Make the move to a superior design environment – and take your designs with you

Software applications are the tools of trade today, and as such need to continue to refine and mature as your needs and capabilities grow. Altium strongly believes in this, and appreciates how much a small improvement can actually deliver more to your productivity than a big new feature.

Improvements should not only enhance the way the software works, they should also bring new concepts and paradigms to create better ways of working. Consider how often you copy and paste – wouldn’t it be good if you could transform data during that copy / paste operation, transforming those 64 net labels into 64 ports with wires for example? Altium Designer 6 incorporates a large number of environment improvements. Some are based on feedback from designers, while others, like the smart paste feature, introduce new ways of working.

Import Wizard – simplified importing from other design tools

One task that has always been a difficult challenge is moving electronic product designs from one design environment to another. Whether you have changed design tools or acquired designs from another company, at some stage you will need to import a schematic or PCB design into Altium Designer.

Altium Designer 6 unifies the import process for importing designs from a variety of different design tools. The new **Import Wizard** walks you through the import process, handling both the Schematic and PCB parts of the project, as well as managing the relationship between them.

![Import Wizard](image)

The architecture of the Import Wizard is designed to allow the easy addition of new importers, without additional complexity for the designer using the system.

From the Wizard you can select to import the following types of design projects:

- Protel 99 SE design databases
- CircuitMaker 2000 schematics and libraries
- DxDesigner® schematics and libraries
- OrCAD® schematic and PCB designs and libraries
- OrCAD® CIS configuration files and libraries
- OrCAD® schematic with PADS® PCB designs
- PADS® ASCII schematic and PCB designs and libraries
- P-CAD schematic and PCB designs and libraries (binary and ASCII)
Transform objects as you Smart Paste

As an engineer, you know there are a large number of objects to be placed and connected as you build up your design. A common technique to accelerate this process is to copy similar objects that you have already used, paste them to where you are currently working, and modify them as required.

The schematic editor’s new **Smart Paste** feature takes this approach to an entirely new level – using Smart Paste you can actually transform the copy of the selected objects into other objects as you paste them. For example the selected Net Labels can become Ports when pasted, or the selected Sheet Entries can become Ports+Wires+Net Labels, all in a single paste action.

![Figure 80. Selected Sheet Entries being transformed into Wires+Ports+Net Labels as they are Smart Pasted.](image)

You also have complete control over which of the objects in the selection set you want to paste – no more carefully avoiding those wires as you select the Ports, simply clear the checkbox to ignore wires when you Smart Paste your selection.

Another handy feature is the ability to paste the selected circuitry as a graphic. Using this you can easily include a graphic or section of circuit on another sheet, and size it as required. Select **Edit » Smart Paste** to transform the clipboard objects as you paste them.

Smart grid insert and paste

Creating and manipulating large amounts of data for library components can be a time-consuming and error-prone process. Available as right-click options from the **List** panel of the Schematic and PCB main and library editors, the **Smart Grid** commands streamline this process – saving you valuable time when updating or creating new object data from an external spreadsheet or table.

**Smart Grid Insert** creates new objects from copied spreadsheet data, and **Smart Grid Paste** alters the values of existing objects currently selected in the **List** panel.

Once the source spreadsheet data has been copied onto the clipboard, right-click in the List panel to access the commands. The **Smart Grid** dialogs allow you to map columns in the source data, to columns in the **List** panel. If the source data includes a Header Row then you can use the **Automatically Determine Paste** button to match all columns in a single action. Altium Designer object data is not changed until the **OK** button is pressed.

![Figure 81. Creating new pins with the Smart Grid Insert command.](image)
Enhanced Favorites panel

Moving around a large or complex design can mean lots of switching documents and zooming in and out as you work. The Favorites panel will help you manage the task of moving around your design, in it you can store the current document view position and zoom level for later re-use. Double-clicking on a View in the Favorites panel will open the document, and restore the view and zoom level exactly as you defined it, making it an ideal way of jumping between different areas of the board design, or jumping back and forth from part of the schematic to that circuitry on the PCB.

Use the Favorites system to communicate design issues between your design team. For example, one designer can zoom on an area of the PCB and add this area as a favorite together with some comments. Another designer can then open the project and read the comments and click on the thumbnail to be taken to the specific view to see the issue.

Views can kept with the project, or they can be kept in the Favorites View folder, making them available regardless of the design that you have open.

In place text editing

Text presented in a Schematic Note or Text Frames can be edited directly on the Altium Designer 6 schematic, speeding the editing process, and allowing you to see the layout of the text as you type.

Multi-wire / multi-track editing

Do you find that you often need to extend a group of wires? Then you’ll appreciate the new multi-wire editing mode in the schematic editor. If multiple parallel wires share a coordinate for their end vertex, then when you click and drag to move the end of one wire vertex the end vertex of all other selected wires will also move, keeping the wire ends aligned.

The ability to extend multiple objects has also been added in the PCB editor. With multiple track segments selected, choose Move / Resize Tracks from the Move sub-menu and click to resize all selected segments.

Toggle port direction

Port directions can now be flipped at the click of a button. You can select one or several ports and flip them using the option in the right-click menu.

Automatic Sheet Entry creation

Another handy addition to Altium Designer is the new Place Sheet Entries automatically option. With this option enabled a sheet entry is defined automatically when you wire up to the edge of a Sheet Symbol. The name will be taken from an existing net identifier on the net, and the IO direction set to suit any connected pins, ports or sheet entries.
Improved Sheet Entry editing

The style of Sheet entries can now be changed, as well as the font. Placing and editing has is now more intelligent, you no longer need to pre-select the sheet symbol before placing a sheet entry, and sheet entries can be dragged from one symbol to another.

User-definable mouse wheel behavior

Altium Designer supports the Microsoft Windows standard mouse wheel behavior, making it easy to move between Altium Designer 6 and other Windows applications. Appreciating that every designer has their own preferences and style, Altium Designer now supports reconfiguring the mouse wheel, making it possible to re-map the current wheel/key combinations to your user-preferred settings.

Fast mouse zoom

Whether designing a schematic or a PCB, it’s important to have efficient and intuitive control over the view of the document. The Mouse Zoom extends control over the document view in both the schematic and PCB editors, and can be used independently or in conjunction with panning, giving you flexibility and control.

- To use as an accelerated zoom feature, click and hold the Mouse Wheel, then drag the mouse up and down to zoom in and out.
- To use with panning, click and hold the Right Mouse button to activate panning, then press Ctrl to activate mouse zoom.
Show designators in Library

The location and font of the schematic component designator and comment can now be fully defined in the library editor. To maintain manual positions during placement on the schematic, edit the designator and comment strings and disable the auto-position option for each.

![Library Editor Workspace](image1)

Figure 89. Display and position the component designator and comment in the Library Editor. The dots next to the designator and comment indicate that these string are manually positioned, disable the Mark Manual Parameters option to hide the dots.

Extended local language support

Altium Designer has in-built support for detecting and working in the language locale of the Windows installation. Supported languages include:

- French
- German
- Japanese
- Simplified and Traditional Chinese
- Korean

Altium Designer 6 dialogs, menus and hints present in the local language. Set the **Localization** options in the **Preferences** dialog.

Microsoft Windows Vista® supported

Considering your system’s readiness for Windows Vista? Altium Designer 6 has been tested and is compatible with Windows Vista. You can deploy Altium Designer across your organization knowing that you not only get the most productive design system available, but also the security and confidence of knowing that Altium is committed to ensuring you can smoothly transition your electronic product development solution to the latest version of Windows.
Mixed-signal circuit simulation is an important part of the design process for many engineers. Enhancing its flexibility, Altium Designer 6’s Spice circuit simulator now supports PSpice® models, functions and global variables. The circuit under simulation can now reference any mixture of Spice 3f5 models, XSpice models and PSpice models.

**PSpice® support – models, functions and global variables**

The PSpice simulation model format is the format of choice for many device manufacturers. Altium Designer 6’s circuit simulator now has strong support for PSpice models. PSpice models are used in exactly the same way as Spice 3f5 models, simply hook them up in the graphical symbol-to-model editor, and start simulating. There is also excellent support for PSpice functions.

Support for global parameters and equations

Global parameter and equation support has also been added to the circuit simulator. Use a global parameter in an equation, and use that equation in a component value on your schematic. Alternatively, define the equation as a global parameter, and then reference the global parameter from a component value.

Simply include the expression or parameter name within curly braces {}, when the simulator detects this it will attempt to evaluate it, checking the Global Parameters page of the simulator’s Analyses Setup dialog for the definition of any part of the expression that cannot be immediately resolved. The new Global Parameters example has been added to the Circuit Simulation folder to demonstrate global parameter and equation support.

**X-axis equation support**

Previously it was not possible to use the simulation waveform X-axis in the construction of a new equation-based waveform. This is now possible in Altium Designer 6, simply right-click in a plot and select Add Wave to Plot, the current X axis is included in the list of Waveforms, ready to be used as part of an Expression.
SIMetrix/SIMPLIS®

Altium Designer 6 supports the SIMetrix/SIMPLIS® circuit simulation package from Catena. SIMetrix/SIMPLIS is a circuit simulation suite optimized for the design and development of electronic power systems. SIMetrix/SIMPLIS is a combination of two independent circuit simulators: SIMetrix, a SPICE-based simulator with numerous enhancements including extra models for power transistor devices, and SIMPLIS, a fast simulator that uses piecewise linear approximations and includes useful analysis modes for switching power supply circuits.

Altium Designer supports SIMetrix/SIMPLIS in three main ways:

- Importing models from the SIMetrix/SIMPLIS model library
- Direct simulation from Altium Designer in SIMetrix/SIMPLIS
- Exporting schematics containing simulation models to the SIMetrix/SIMPLIS format.

The Altium Designer to SIMetrix/SIMPLIS interaction is configured in the Simulation – SIMetrix Interface page of the Preferences dialog. Once this is done two new menu commands will appear: Design » Simulate » SIMetrix and Design » Simulate » SIMPLIS.

Most simulation models from the Altium Designer 6 libraries can be used in SIMetrix/SIMPLIS. You can also import models from the SIMetrix/SIMPLIS model library into Altium Designer, as well as using a mixture of both. If you have multiple models for a component that have been tuned for each simulator, then you can attach them all to the component. Whenever you run a simulation, Altium Designer will choose the best one for your target simulator.

![Figure 91. To run a simulation in SIMPLIS, select the Design » Simulate » SIMPLIS command.](image)

To export your Altium Designer schematic to SIMetrix/SIMPLIS format, launch File » Export File to SIMetrix. This is useful if you want to run many simulations in SIMetrix/SIMPLIS or use multi-step analysis modes that are not directly supported in Altium Designer.

**Note:** you must have a SIMetrix/SIMPLIS (release 5.3j or higher) license to use this feature.
**Excluding component parts from a simulation**

One of the great strengths of Altium Designer’s component modeling system is that it supports building one component that can be used in all design domains – including schematic capture, PCB layout, 3D modeling, signal integrity analysis, and SPICE mixed-signal circuit simulation.

---

**Figure 92.** Enabling the Exclude part from simulation checkbox instructs the simulator to ignore this part, but add its pins to all other parts.

SPICE mixed-signal circuit simulation support has been enhanced by the addition of the new Exclude part from simulation option – now you can set any part in a multi-part component to be excluded from the simulation, particularly useful if you design your components with the power pins on a separate part. Those power pins are still required in the Spice netlist of course, so when a part is set to be excluded its pins automatically appear in the schematic pin list for all other parts in the component, ready to be mapped to the pins defined in the model file.
9. Embed an entire system in an FPGA – no new skills needed

A unified electronic product development solution

If your current design does not include an FPGA, there is a good chance that one soon will. Falling prices and growing capacities mean that FPGAs are not only a viable option for housing large sections of circuit logic, they can support an entire processor-based embedded system. Altium Designer is the world’s first unified electronic product development system that allows you to take a design from concept to completion within a single application. Altium Designer brings together hardware, software and programmable hardware development within a unified environment, which allows all aspects of an electronic product to be designed and managed within a single system.

From the comprehensive range of supported devices from all major vendors, through the LiveDesign interactive development capabilities, to the expanding range of NanoBoard development platforms, Altium Designer makes it possible to develop and debug an entire system on an FPGA.

Broad range of device support for all major device vendors

One of Altium Designer’s strengths as an FPGA development platform is its vendor independence. With Altium Designer you can complete a design on one vendor/device, and quickly migrate it to a different vendor/device. Device support now covers a large range from all the major vendors.

At the time of going to press, supported devices includes:

<table>
<thead>
<tr>
<th>Actel®</th>
<th>Altera®</th>
<th>Lattice®</th>
<th>Xilinx®</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProASIC3</td>
<td>MAX II</td>
<td>MachXO</td>
<td>CoolRunner-II</td>
</tr>
<tr>
<td>ProASIC3E</td>
<td>MAX 3000A</td>
<td>LatticeEC</td>
<td>CoolRunner XPLA3</td>
</tr>
<tr>
<td>ProASICPLUS</td>
<td>MAX 7000AE</td>
<td>LatticeECP</td>
<td>Spartan-II</td>
</tr>
<tr>
<td>Fusion</td>
<td>MAX 7000B</td>
<td>LatticeECP2</td>
<td>Spartan-III</td>
</tr>
<tr>
<td></td>
<td>MAX 7000S</td>
<td>LatticeECP2M</td>
<td>Spartan-3</td>
</tr>
<tr>
<td></td>
<td>Cyclone</td>
<td>LatticeXP</td>
<td>Spartan-3A</td>
</tr>
<tr>
<td></td>
<td>Cyclone II</td>
<td>LatticeSC</td>
<td>Spartan-3E</td>
</tr>
<tr>
<td></td>
<td>Cyclone III</td>
<td>Lattice</td>
<td>Spartan-3L</td>
</tr>
<tr>
<td></td>
<td>ArriaGX</td>
<td>Lattice</td>
<td>Virtex</td>
</tr>
<tr>
<td></td>
<td>Stratix</td>
<td>Virtex-II</td>
<td>Virtex-II</td>
</tr>
<tr>
<td></td>
<td>Stratix GX</td>
<td>Virtex-II Pro</td>
<td>Virtex-5</td>
</tr>
<tr>
<td></td>
<td>Stratix II</td>
<td>Virtex-4</td>
<td>Virtex-E</td>
</tr>
<tr>
<td></td>
<td>Stratix II GX</td>
<td>Virtex-5</td>
<td>XC18V00</td>
</tr>
<tr>
<td></td>
<td>Stratix III</td>
<td>XC9500</td>
<td>XC9500XL</td>
</tr>
<tr>
<td></td>
<td>Stratix III GX</td>
<td>XC9500XV</td>
<td>XCF</td>
</tr>
</tbody>
</table>

Visit the Altium website for the latest list of supported devices.
http://www.altium.com/Community/VendorResources/VendorDevices/
A choice of processors – with the ability to change

For too long, designers have become locked into a processor family for all the wrong reasons. While the chosen processor might have been the most appropriate when it was first selected, the investment in developing non-portable source code and the programming and debugging resources needed to support the processor, locks the organization to that processor. The result is that it can end up being used well beyond its ideal lifespan.

As well as including embedded toolchains for all supplied and supported processors, Altium Designer 6 brings the beginnings of true processor independence. It is now possible to seamlessly move an embedded software design between soft-core processors, hybrid hard-core processors and discrete processors. This is possible because all processors are wrapped by a Wishbone OpenBus wrapper, which allows peripherals defined in the FPGA to be used transparently with any type of processor. An FPGA OpenBus wrapper around discrete, hard-wired peripherals also allows them to be moved seamlessly between processors.

Each processor is fully supported with Altium’s highly optimizing TASKING Viper C-Compilers, along with full source-level JTAG-based debugging.

This combination of device and processor software systems, together with normalized FPGA-based wrappers, makes the processor-based system look the same to the application code. There is still full access to processor and peripherals features, including the hardware or software vectored interrupt systems.

High performance compiler technology

Underlying all the 32-bit processor embedded toolchains is Altium’s Viper compiler technology. The Viper compiler delivers highly optimized code with a small footprint and fast execution times. The toolchain includes Viper C-Compiler, CrossView debugger, instruction set simulator and profiling tools. And by using the common Viper compiler across all 32-bit processors, code can easily be moved from one target to another.

Select from a range of 32-bit processors

Appreciating that final processor selection will be dictated by many factors, Altium Designer 6 supports a range of soft, hybrid and discrete 32 bit processors. Designs can be shifted from one processor to another, during the development process.

<table>
<thead>
<tr>
<th>Altium®</th>
<th>Actel®</th>
<th>Altera®</th>
<th>AMCC®</th>
<th>NXP®</th>
<th>Sharp®</th>
<th>Xilinx®</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Discrete ARM7</td>
<td>BlueStreak LH795xx series</td>
<td>Embedded PowerPC PPC405</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Discrete ARM9</td>
<td>BlueStreak LH7A404</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 93. Full embedded toolchain and implementation support is provided for a range of soft, hybrid and discrete 32 bit processors
ARM soft & discrete processors

Altium Designer 6 includes a complete Viper tool-chain for ARM-based processors. This includes support for the following ARM core families:

- Actel CoreMP7
- ARM7 Family – ARM720T, ARM7EJ-S, ARM7TDMI and ARM7TDMI-S
- ARM9 Family – ARM920T and ARM922T
- ARM9E Family – ARM926EJ-S, ARM946E-S, ARM966E-S and ARM968E-S
- ARM10E Family – ARM1020E, ARM1022E and ARM1026EJ-S

Altium Designer 6 also includes wishbone wrapper support for the following discrete ARM processors:

- NXP LPC2000 series
- Sharp LH79520 (ARM720T)
- Sharp LH754xx series (ARM7TDMI)
- Sharp LH795xx series (ARM720T)
- Sharp LH7A404

PowerPC hybrid & discrete processors

Altium Designer 6 includes a complete Viper tool-chain for PowerPC-based processors, and wishbone wrapper support for the following PowerPC devices:

- Xilinx Virtex-2 Pro hybrid PowerPC, PPC405
- Xilinx Virtex-4 FX hybrid PowerPC, PPC405
- AMCC PowerPC 405 discrete processor family

Xilinx® MicroBlaze® softcore processor

The Xilinx MicroBlaze processor has been integrated with Altium Designer 6. This allows designs to be completed that take advantage of this highly optimized FPGA-based processor. The MicroBlaze support includes a the highly optimizing Viper C-Compiler that provides significant improvements over the free GNU based open source compiler provide with the Xilinx tools. The MicroBlaze processor can only be used with Xilinx FPGA devices. To use the MicroBlaze within Altium Designer, the Xilinx EDK is required along with a valid MicroBlaze license.

Altera® Nios® II softcore processor

If the Altera® Nios® II is your embedded processor of choice, then you will be pleased to hear that Altium Designer 6 brings full embedded tool chain support for the latest range of Nios II embedded processors.

Working in Altium Designer’s professional coding environment, your code is compiled by the TASKING Viper compiler, producing highly optimized application code that is substantially more compact than that produced by the GNU compiler. Debug your code running on the target Altera FPGA directly from within Altium Designer – on an Altium NanoBoard, a third-party FPGA development board, or directly on your product board.

Altium TSK3000A 32-bit RISC Processor

The TSK3000A is a 32-bit, Wishbone-compatible, RISC processor. Most instructions are 32-bits wide and execute in a single clock cycle. In addition to fast register access, the TSK3000A features a user definable amount of zero-wait state block RAM, with true dual-port access.

The TSK3000A has been specifically designed to simplify the development of 32-bit systems targeted for FPGA implementation, and to allow the migration of existing 8-bit systems to the 32-bit domain with relative ease and low-risk. As a result, complications typically associated with 32-bit system design, such as complex memory management, are minimized.

The TSK3000A, although a ‘classic RISC’ processor and internally based on the Harvard architecture, features a greatly simplified memory structure and sophisticated interrupt handling to make coding simpler. The processor also simplifies the connection of peripherals with support for the Wishbone microprocessor bus.

The TSK3000A can be used with any FPGA device of suitable capacity supported by Altium Designer 6, giving a completely device and FPGA vendor-independent 32-bit system hardware platform.

Wishbone OpenBus Processor Wrappers

To normalize access to hardware and peripherals each discrete processor has a wishbone OpenBus-based FPGA core that 'wraps' around the processor. The OpenBus wrappers can be implemented in any FPGA, and allows you to implement FPGA-based portable cores, taking advantage of the device driver system in Altium Designer 6 for both FPGA-based soft-core peripherals as well as connections to off-chip discrete peripherals and memory devices.

In addition to this, the configurable memory controller can be used to connect to various types of off-chip memories.
Processor Abstraction System

This new system provides a plug-in processor abstraction system that normalizes the interface to interrupt systems and other hardware specific elements. The system provides an identical interface to the processor's interrupt system, whether soft or hard-vectored. This allows different processors to be used transparently with identical source code bases.

Device-Software-Framework (DSF)

Along with the common Viper compiler technology and the processor and hardware abstraction system, a new Device Software Framework (DSF) for embedded projects has been added to Altium Designer 6. The DSF has been designed to simplify embedded application development.

The DSF delivers:

- A Low Level Peripheral Interface (LLPI) layer, with tight integration between the FPGA peripherals and their driver code.
- A Processor Abstraction Layer (PAL) greatly simplifies the portability of your embedded application across all target processors, both embedded and discrete 32-bit, supported by Altium Designer 6.
- While the DSF ‘abstracts away’ most of the physical layer from the embedded application development process, you continue to have direct access to the processor’s interrupt system.

The sample embedded projects included with Altium Designer have been upgraded to use the new DSF. The DSF interface will continue to develop and improve over future releases of Altium Designer.

Traditional Embedded Application

Figure 94: The DSF allows the embedded application to be portable between processors, instead of being tightly coupled to the hardware, as it is in the traditional approach.
**OpenBus – high-level system design**

Altium Designer 6 introduces a more streamlined and abstract way of defining a processor-based system that is to be implemented in an FPGA. Previously requiring the use of traditional wired-hardware components, the OpenBus system allows this once difficult task to be accomplished in a more visual and intuitive way.

The OpenBus system abstracts the bus complexity of a large number of nets and buses, into a single connection line. Components are placed from a palette, and linked to each other via the Link button on the OpenBus toolbar.

Using this approach, a complex processor based system that interfaces to numerous peripherals and types of memory can quickly be constructed.

---

**Figure 95.** The OpenBus system provides a high-level, abstract alternative approach to defining a complex processor based system in an FPGA.

The OpenBus document (*.OpenBus) and OpenBus System editor look similar to Altium Designer’s schematic editor, with its own menu and toolbar for the creation of an OpenBus system. OpenBus objects are edited using the Inspector and List panels, or if configurable, can be configured via the right-click menu.

The **OpenBus Palette** gives access to a range of processor, memory, peripheral and IO objects. The panel is available when an OpenBus document is open, and can be accessed from the OpenBus button at the bottom right of the workspace.

---

**Figure 96.** OpenBus objects are placed from the Palette

**Figure 97.** Wired-hardware version of the design shown above
**Design in C – implement in hardware**

System partitioning, or working out what to implement in physical hardware, programmable hardware, and software, is one of those tasks that is often done earlier than you would like. It’s not easy to trade off processor execution time against component costs, so the partitioning process usually involves many educated guesses, and a good dose of luck.

Encryption algorithms, image manipulation and signal processing are good examples of computational algorithms that, while being relatively straight-forward to code and debug in software, are inherently parallel in nature. They place heavy demands on the processor and are better served by being implemented in hardware.

These types of design challenges exploit what is probably the biggest advantage of an FPGA – their parallel nature. FPGAs are superb at performing multiple operations simultaneously. But shifting something like an image manipulation algorithm from software into hardware has traditionally been very difficult, requiring specialized hardware engineers.

That option can now be explored during development in Altium Designer 6, with the ability to move design functionality from software into FPGA hardware.

C functions are implemented in hardware by including an Application Specific co-Processor (ASP) in the hardware design. Once the ASP is wired onto the bus of the processor, functions defined in the processor’s embedded project can be nominated to be ‘pushed’ into the FPGA logic. The ASP acts as a wrapper, creating an interface between the processor and the function implemented in FPGA logic.

![Figure 98. The Application Specific coProcessor interfaces between the code running on the processor, and the functions implemented in FPGA hardware.](image)

Using this approach, it is possible to switch the implementation between hardware and software by simply toggling an option and recompiling and downloading the embedded code. This makes it easy to do performance comparisons between the hard and soft versions of the function. It also allows the design to be fully debugged as software, and then pushed into hardware. Since the HDL hardware implementation of the function is “correct by construction”, once the code version is error free then the hardware version will also be error free.
Device and vendor independent interface cores, with driver code

The range of core components continues to grow in Altium Designer 6. These sophisticated cores greatly simplify the process of developing an embedded system requiring capabilities such as digital video, I2S audio, or fast floating point calculations.

BT656 digital video interface
The BT656 Video Capture core supports data streaming from high-speed video capture devices. It translates a standard 8-bit ITU-R BT.656 format video stream from a video decoder, such as the Texas Instruments TVP5150. The core performs structural translations and loads the video data, via DMA, into video memory. From there it can be further manipulated, or used directly by the Altium VGA display core.

I2S_W serial digital audio
I2S is a popular serial bus designed for digital audio. The new I2S core provides a convenient wishbone compliant interface for streaming data to or from a high-speed audio codec. The core performs the serial to parallel conversion required to directly interface high-speed serial audio to a microprocessor.

32 bit configurable VGA controller
The WB_VGA is a configurable core that can be configured to operate as one of three 32-bit VGA controllers. The 3 modes include: a standard 32-bit VGA controller with configurable color quality (1,2,4,8bpp), supporting screen resolutions up to 800x600 and screen refresh rate of up to 75Hz; a fixed, 16bpp color mode VGA controller; and a TFT VGA controller with 240x320 screen resolution, 50Hz refresh, and 16bpp color.

JPEG decoder
This core decodes JPG data. It supports grayscale and color baseline (sequential) JPEG, direct decoding to display memory, user selectable image area to decode, and block-based reading or writing. 32-bit DMA can be used for both input and output, and the output pixel format is big-endian RGB565.

Floating Point Unit
The WB_FPU (floating point unit) facilitates the conversion of 32-bit integer values into single precision floating-point numbers, and vice-versa (in accordance with IEEE-754). The core performs these conversions, and additional standard mathematical calculations on two single precision floating-point numbers, with greater speed than software-based floating-point solutions.

Wishbone multimaster
The Multimaster core provides a simple means of sharing a slave Wishbone device between multiple masters (up to 8), with configurable address and data bus widths. It supports passing interrupts from a connected Wishbone Interconnect, through to all connected 32-bit processor masters.

Wishbone shared memory controller
The Shared_Memory_Controller supports asynchronous SRAM, synchronous DRAM, block RAM, and parallel FLASH. The core is highly configurable, making it a straightforward process to connect different memory types, sharing a common bus, to the processor. Different memory speeds are supported, configured for in the controller.

1-WIRE® Master controller
The 1-Wire® Master Controller facilitates communications between the system processor and external 1-Wire-compatible peripheral devices, over the 1-Wire serial bus. The Controller handles all timing and control signals required to satisfy the 1-Wire protocol. Once mapped into the processor's peripheral I/O space it is seen and used by the processor as a dedicated 1-Wire port. The processor simply sets up interrupts, issues control commands, and sends and receives data.

IDE interface controller
The WB_IDE controller provides a wishbone-compliant interface between interfaces an IDE compliant device, such as a disk drive, and the system processor and memory.

Infrared encoder
The WB_IRCODER peripheral provides a wishbone-compliant interface between an infrared transmitter and a processor in an FPGA design. The peripheral has been built primarily to interface to the TFDU6102 Fast Infrared Transceiver (from Vishay Semiconductor), however it can also be used to interface to any IR transmitter where the required input signal is already modulated and simply controls the pulsing of the transmitter's IRLED.

Infrared decoder
The WB_IRDEC peripheral provides a wishbone-compliant interface between an infrared receiver and the system processor. The peripheral has been built primarily to interface to the TFDU6102 Fast Infrared Transceiver (from
Vishay Semiconductor), however it can also be used to interface to any photodiode circuit or IR receiver where the output signal is passed on, still in modulated form.

The peripheral handles demodulation of the incoming signal and can be configured to operate in one of two modes – either as a dedicated decoder for data transmitted using the NEC IR transmission protocol, or as a raw interface, allowing the reception of data encoded in any other format. In the latter mode the encoded data is received by the processor, to be decoded in software. It is also possible to perform customizable demodulation of the input signal based on a specified carrier frequency.

**USB interface controller**

The WB_USB peripheral provides the interface between the processor and an external USB Interface device, for subsequent communications over a Universal Serial Bus (USB). The peripheral has been built specifically to interface to the EZ-USB SX2™ device (CY7C68001, from Cypress Semiconductor). This high-speed (USB 2.0) USB Interface device has a built-in USB transceiver and a Serial Interface Engine (SIE), which automatically manages the USB protocol.

**Application Specific coProcessor**

The WB_ASP peripheral is an Application Specific Processor used as a ‘container’ for C source functions that are implemented in hardware using Altium Designer’s C-to-Hardware Compiler (CHC).

Wired into an FPGA design like any other peripheral, the WB_ASP gives the host processor access and control over hardware-compiled functions specified in the ASP component. These functions will populate the WB_ASP once the design project has been compiled and synthesized.

When a hardware function is called from the embedded application, the processor transfers values for the function’s parameters to the WB_ASP, starts the function and waits for it to return. If the hardware function delivers a return value, this will be read back by the host processor, to be used in the calling software routine.

**FPGA third party core import Wizard**

In Altium Designer 6 you can readily take advantage of core technology from your favorite third party vendors – through increased linking of vendor-specific FPGA cores with the FPGA design that incorporates them. The new wizard automates importing third party IP cores from FPGA vendor tools, including Actel, Altera, Lattice and Xilinx.

Some features of the **FPGA Third Party Core Import Wizard** include:

- Schematic components and their corresponding libraries are automatically created with the correct parameters (ChildModel parameters), and are ready to use.
- Sheet symbols are created for HDL formats, such as Altera's Megaw function Core Wizard.
- Binary file formats, such as NGC, are supported.
- Ability to declare and instantiate a core in a VHDL or Verilog file is supported.
- Non-design files, such as memory initialization, can be associated as part of the core.

![Figure 99. Multiple IP files are supported. For better management, there are options for copying to a project directory or zipping core files up together.](image)
Configurable 8 to 64 bit Logic Analyzer (LAX)

The FPGA Logic Analyzer is a powerful tool in your design verification and debugging arsenal. Using it, you can monitor the state of multiple nodes inside the FPGA design. Altium Designer 6 sports a new, configurable logic analyzer, that gives you run-time control over which bus or nets are being monitored, and which are being used to trigger off.

The new LAX is a configurable component, supporting 8, 16, 32 or 64 bit capture. It also incorporates an internal multiplexer, using this you can configure the LAX to monitor any number of nets and buses, and then select which set of signals is to be captured while the circuit is under test.

You can also trigger off the external trigger, or define any trigger pattern on any of the available sets of signals.

Right-click and select **Configure** to define the number of nets and buses to be monitored, to name them, and to group them into logical sets.

Figure 100. Feed the required signals into the LAX in sets, then monitor and trigger off any set during runtime.
Disassemble the LAX data

If you have used a logic analyzer with a processor then you have probably wished you could easily interpret the data being captured as the code under execution.

Altium Designer 6 delivers this ability – simply select the processor being monitored in the LAX Data panel and a disassembly column will be displayed, giving you immediate feedback on the state of your code. You can also display disassembled instructions in the waveform viewer.

Figure 101. Use the new disassembly view to interpret the LAX data as processor instructions.

Intelligent Instrument Probes

LiveDesign is the name given to Altium Designer’s unique real time testing and debugging capabilities – where you can implement the design in a target FPGA and then interact with it using the virtual instruments and embedded processor debuggers. Your LiveDesign capabilities have been enhanced with the addition of Instrument Probes.

Instrument Probes simplify the task of connecting the net of interest up to the instrument, for example the logic analyzer. You no longer need to wire that net up through the design hierarchy to the sheet with the instrument on it, the instrument probe instructs the system to connect the net being probed directly to the instrument. The Instrument Probe can be placed on any schematic that is lower in the design hierarchy than the sheet the instrument is on.

Figure 102. Instrument Probes let you monitor any point in the design without having to wire through the design hierarchy to the instrument.
Perform console IO with the Terminal Console

Console I/O is a common way of debugging a processor-based system. By including a Terminal Console instrument in your FPGA design, you can interact with the processor during software execution. The Terminal Console can be used to display monitor type information from the processor, or you can type text into the instrument panel to control or interact with the processor during code execution.

Switch multiple buses with the Crosspoint Switch

The Crosspoint Switch allows you to implement a run-time configurable switching matrix in your FPGA design. It can be configured to support any number of input and outputs. The switching patterns can be defined before the design is compiled, or once it has been downloaded to the target device.

Scan any JTAG device in real time

Boundary scan, or JTAG, as it is more commonly known, was developed as a system for testing digital integrated circuits mounted on the assembled printed circuit board, and for testing the interconnects provided by that board. Altium Designer 6 brings this level of JTAG testing to your development environment – right on your own project board.

Altium Designer has a complete JTAG communications system, and with the release of Altium Designer 6 this has been extended to support all JTAG compliant devices. By including the standard BSDL file supplied with each JTAG compliant device you have access to the pins on every JTAG device in your design, through the enhanced real-time JTAG viewer.

Enhanced Generic JTAG Device Support

Altium Designer’s JTAG communications system has been enhanced to support all JTAG compliant devices. By including the standard BSDL file supplied with each JTAG device you have access to the pins on every JTAG device in your design.

The system even supports the situation where a BSDL file is not available for a device – simply set the instruction length for this device to zero and the JTAG system will continue to communicate to other devices in the chain.
Enhanced Real-Time JTAG Device Viewer

High density surface mount component packaging systems, such as Ball Grid Arrays (BGAs), mean that physically probing device pins is no longer possible – presenting you with a real challenge when it comes to debugging your design. Enter Altium Designer’s enhanced Real-Time JTAG Device Viewer – physical design debugging has now moved to a new level.

The JTAG Device Viewer uses the JTAG communications standard to interrogate the state of the pins in any JTAG compliant device in your design, not just the FPGAs. It presents the state of each pin, and includes an image of both the schematic symbol and the footprint, helping you to analyze and debug your design.

View the action on the PCB

Design debugging support also extends back to the design documents. Previously Altium Designer supported displaying the pin states back on the schematic, with the release of Altium Designer 6 you can also display the pin states on the PCB design – ideal for analyzing your design’s performance.

Figure 105. Examine the state of pins for any JTAG compliant device in your design.

Figure 106. Monitoring the changing state of device pins on the PCB.
Schematic back-annotation from vendor pin files

FPGA schematic components can now be updated directly from the FPGA vendor pin file. Back-annotation data support includes pin name and electrical type. This feature does not require the FPGA to have been designed in Altium Designer, all popular vendor pin files can be read directly.

Use the **Import FPGA Pin File** command in the right-click **Part Actions** submenu to import a pin file.

Full design flow support for Verilog

Verilog support was enhanced in Altium Designer 2004 SP4, with the introduction of support for Verilog blocks in your design. This support has been further upgraded with the introduction of a Verilog netlister, allowing you to use Verilog throughout the FPGA design process.

```verilog
module MyNewCore (
    input rst,
    input [1:0] clk_sel,
    input [1:0] KEY
);  
output [1:0] ADDR;
output [1:0] WE;
output [1:0] RD;
output [1:0] KEY,
```

Figure 108. Verilog can now be used throughout the design flow in Altium Designer 6, with the addition of a Verilog netlister.
**Improved embedded code editor**

**Visible change tracking and persistent Undo stack**

Design debugging support extends back to the design documents. Appreciating how difficult it can be to work with, and keep track of changes you have made in complex pieces of code, Altium Designer 6.7 delivers two new complimentary options in the Text Editor.

Previously, your Undo data was lost after the saving of a text file. You’ll appreciate that now Undo/Redo data is kept after saving, allowing you to revert all changes you may have made. Set in the Text Editors – General page of the Preferences dialog, this option is enabled by default.

Text lines that are modified or added are now automatically highlighted with color markers in the gutter. Unsaved changes are indicated with red markers, while saved changes are indicated with green markers – allowing you to quickly identify how much of your work is committed.

**Improved embedded system editing features and performance**

A number of enhancements have been made to the embedded code editor:

- Advanced block editing – block select several lines and type text all simultaneously
- Smart Home key, jumps to first non-space character in the line
- Show line numbers at every tenth line

Altium Designer 6 also has improved responsiveness when large embedded projects and project files are opened. Enhancements focus on the following areas:

- Opening large source documents
- Loading libraries
- Switching documents
- Projects that are linked to a VCS
- Panel responsiveness.

```
82   LCD_WR_Byte(0x0E);
83   while (LCD_BUSY)
84       ;
85
86   LCD_WR_Byte(0x0E);
87   while (LCD_BUSY)
88       ;
89   
90   #endif
91 }
92 void LCD_WriteNibble(unsigned char X)
93 {  
94     #ifndef LCD_DISABLE
95     if (X >= 0x0F)
96         return;
97     
98     if (X > -0x10)
99         LCD_Fetch('A' - 10 + X);
100   
101     else
102         LCD_Fetch('0' + X);
103   #endif
104 void LCD_WriteString(const char * str)
105 {
106     #ifndef LCD_DISABLE
107     while (* str)
108     {
109         LCD_Fetch(* str++);
110     }
111     #endif
112 }
113
114 void LCD_WriteChar(unsigned char c)
115 {
116     #ifndef LCD_DISABLE
117     while (LCD_BUSY)
118         LCD_Fetch(c);
119     #endif
120 }
121 void LCD_Write32bit(unsigned long int X)
122 {
123     #ifndef LCD_DISABLE
124         LCD_Write1bit(X >> 16);
125         LCD_Write1bit(X & 0x0000FFFF);
126     #endif
127 }
128 void LCD_WriteXY(unsigned char X, unsigned char Y)
129 {
```

Figure 109. Color-coded markers in the Text Editor give you immediate visual feedback showing you which change you have saved.
Extended access to FPGA vendor options

More options have been added in Altium Designer 6 for access to the Third Party Vendor Tools Options. It is now possible to use show or hide the Advanced Options, and either specify those options that you would like to use in the various sub-stages of the main Build stage, or those associated with the process flow for a particular physical device.

Figure 110. Advanced and custom build stage options give you full control over every build stage. The ability to insert custom command lines is also available.
10. Keep up to date with Altium Designer

While we all look forward to installing that new software release, there never seems to be enough time to learn how to use all the new capabilities. Appreciating this, Altium offers a variety of ways to learn about Altium Designer 6.

If you prefer to watch instead of read, then why not visit the DEMOcenter, where you can watch a short demonstration about new features in the software. And when you are ready to move to Altium Designer 6 then you’ll find the TRAININGcenter invaluable – short, focused videos that teach you how to get results with Altium Designer 6.

Alternatively, try the Knowledge Center built into Altium Designer 6. Not only does it dynamically present information about the current command, object or dialog, you can also browse and search the extensive PDF-based documentation library from there as well.

The Knowledge Center – help at your fingertips

The Altium Designer documentation has been reorganized and restructured to make it more accessible to you. The documentation is accessed through the new Knowledge Center panel.

The Knowledge Center panel presents help information while you work. It tracks the command, dialog, object, or panel that is currently under the cursor and loads help about it – hover for a second or so for the content to appear. Want to keep the current content that is displayed? Then click the Autoupdate button to disable auto-loading. You can still use F1 to load content with autoupdate disabled.

The Knowledge Center is a portal, from the concise help summary displayed in the top of the panel there are links to PDF based reference and applied documents.

The lower section in the panel has a navigation tree, use this to browse through the PDF-based documentation, and open a document of interest.

The Knowledge Center includes a powerful PDF searching feature, available at the bottom of the panel. Pages that include all words in the search string are returned (except common words such as and, or, etc). The search scope is determined by your current location in the navigation structure.

Figure 111. Use the Knowledge Center to learn about what you are doing, or use it to browse and search the extensive PDF-based documentation library.
Easy Access to Keyboard Shortcuts

Perhaps the single thing you can do to become more productive in any software environment is to learn the shortcut keys. Keystrokes are more efficient than carefully positioning a mouse over a button or drilling through menus, and once learned become second nature.

In a multi-editor environment like Altium Designer it can be hard to remember the shortcuts, particularly those special-purpose ones that are available when you are running a command.

To help with this, a new shortcut menu has been added, which can be used from within all interactive Schematic and PCB commands. When a command is running, for example Interactive Routing, simply press Shift+F1 (or the tilda (~) key) and a menu will appear, listing all of the valid shortcuts for that stage of the interactive command. Use the menu to read the shortcuts, or use it as a menu and select the required option with the mouse.

There is also a new Shortcuts panel that displays keyboard shortcuts available in Altium Designer. The panel is context aware, not only does it update as you move from one editor to another, it also updates when you select a command, showing the available in-process shortcuts. This is ideal for designers that move back and forth between design applications and find it difficult to remember that favorite shortcut.

Web Update

Altium Designer 6’s web update feature makes it very easy to keep your Altium Designer software, libraries and documentation up to date. As well as checking for available updates on the Altium Website, you can also configure it to check a network location – ideal if your company has multiple installations of Altium Designer.
Seeing is Believing

A commonly stated saying is that Seeing is Believing. Learning by watching and listening is something we do naturally, and is an ideal way to learn about computer software. The Altium website includes 2 excellent sets of resources for learning about Altium Designer 6 – the DEMOcenter, and the new TRAININGcenter.

Watch the software in action at the DEMOcenter

The DEMOcenter is ideal for browsing through Altium Designer 6 extensive range of capabilities. Short videos, developed by Altium's applications software engineers, are designed to give you an overview of the major features and benefits within Altium Designer 6.

Click the link below to visit the DEMOcenter.

http://www.altium.com/Evaluate/DEMOcenter/

Figure 114. You'll find a wealth of information about the new features in Altium Designer 6 at the online DEMOcenter, where you can watch short videos that demonstrate the features.
Update your skills at the TRAININGcenter

When you’re ready to harness the power of Altium Designer 6, why not drop into the TRAININGcenter at the Altium website. The TRAININGcenter offers a growing resource of focused videos, each one teaching you how to perform a specific design task in Altium Designer 6.

Altium appreciates the importance of training, and believes that it needs to be delivered in a way that works for you and your organization – that’s the motivation behind the TRAININGcenter. It is a living resource, fuelled by your questions and needs, so keep popping back and continue to build your knowledge of how to design in Altium Designer 6.

Click the link below to visit the TRAININGcenter.
http://www.altium.com/community/TRAININGcenter/

Figure 115. Visit the TRAININGcenter to learn how to harness the power of Altium Designer 6. The growing resource of videos will include captions, in multiple languages.

2007 Altium Limited
November 2007